Software FAQ Lists for
PREMIER+ 2 for Windows

PREMIER+ 2 Card Shop

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 /| Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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Make sure the PREMIER+™ 2 Card Shop window is maximized by clicking the Maximize icon on the title bar.
Click Zoom To Fit to expand the project so it fills the work area.

To deselect a design or some text, click the mouse on another area. To select the desired design, click on it and
an outline box will appear.

Certain functions are only available if the full PREMIER+™ 2 Embroidery System is owned, for example the Color
PhotoStitch options in the PhotoStitch Wizard. If you do not own the full system these functions will be grayed out
(unavailable).



Frames with running stitch that is vertical or horizontal are not always completely visible at zoom to fit. This varies
depending on the font, size of lettering and envelope. Use the Zoom In feature, if desired, to verify that the
stitching exists.

cDoo6 | cannot change the text in the lettering that | selected.

Some pieces of cross stitch lettering are actually designs, so only their color can be changed. If the pointer is a
letter A, the block is lettering. If it is a flower head, the block is a design.

cD007 The desired number is not available for the birthday or anniversary card |
want.

Some decorative lettering may appear to be a design, for example the Pioneer Kids lettering. The number can be
changed. Right-click the number and change it in the Text Properties dialog box.

If the pointer is a letter A, the block is lettering. If it is a flower head, the block is a design.

cD008 | am using variegated thread, but the full range of colors is not showing.

Each letter starts with the initial variegated thread color. Where low density stitching is used the other colors may
not be seen. For a more realistic preview showing all colors, use Print Preview in PREMIER+™ 2 Embroidery.

cDo09 | want to make a new background fabric.

You can create new fabric backgrounds for your cards in PREMIER+™ 2 Embroidery Extra. If PREMIER+™ 2
Embroidery is owned, you may load fabric backgrounds, but cannot create new ones.

cbo1o0 Why is the background fabric shown differently for Single and Multiple
embroideries?

If you select Single embroidery when creating a card and use a fabric background, when Print Overview is
selected in Page Setup the card will be displayed on a single piece of fabric. If you move the fabric background,
the fabric for all pages in the card will be affected.

If you select Multiple embroideries when creating a card and use a fabric background, when Print Overview is
selected in Page Setup the card will be displayed as if on separate pieces of fabric. If you move the fabric
background, only the fabric for the selected page will move.

cbo11 How do | stitch my embroideries?

There are no Send icons in PREMIER+™ 2 Card Shop. To stitch your card embroideries, open them in
PREMIER+™ 2 Embroidery or send them to your machine using the PREMIER+™ 2 Explorer Plug-in.

cDo012 Your selected hoop is too small for your chosen size. Please select a
larger hoop. Alternatively select a smaller size.

Your selected hoop is not large enough for your chosen project. Select a larger hoop, or choose a smaller project.

cbDo13 One or more pieces of text is too large. Reduce the size or the gap and
try again.
This message may appear when saving a project. This means that some part of your card design is not entirely

within your project area (it is outside the edge of the background). Reduce the size of the text by changing the
wording, or changing the size of the lettering.



CS006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

cT013 Error: "Please select a valid thread."
This message appears if you attempt to click OK in the Color Selection dialog box when MyThreads is selected
as the thread range and MyThreads is empty.

To prevent this message appearing again, use Thread Cache in PREMIER+™ 2 Configure to add at least one
thread to MyThreads.

DA009 Some of the icons in the toolbar are 'grayed out'’

Certain toolbar icons (such as Undo before anything has been done) are only highlighted once an embroidery is
shown on the screen, or some other action has taken place.

Dcoo1 What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

DC003 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."



This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM010 "Error. Font file is corrupt.”

This message appears when trying to select or use a lettering style if the file has corrupted. Reinstall the font.

This may also appear if a font is created in PREMIER+™ 2 Font Create and has no characters defined. Use
PREMIER+™ 2 Font Create to define at least one character in the font.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM030 All the lettering appears in uppercase, even though | have typed
lowercase characters in the Letters box

You are using an uppercase font. In an uppercase font (with UC in the name), all the lowercase characters are
identical to the uppercase characters.

EM031 All the lettering appears in lowercase, even though | have typed
uppercase characters in the Letters box

You are using an lowercase font. In an lowercase font (with LC in the name), all the uppercase characters are
identical to the lowercase characters.

EM075 "Error. No letters in font file."

This message may appear if the font is corrupt, or if the character selected is not in that font. Reinstall the font, or
use PREMIER+™ 2 Font Create to add the character to the font.

EM082 Could not load picture file.

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a USB memory stick, then closed and the memory stick removed. It could also appear if the file you
are attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a
proper picture file.

EP006 The thumbnails for my stitch files do not show in Windows® Explorer.

You should first make sure that you have followed the instructions in the following FAQs before following the
instructions below:

« EP005
« EP0OO1

You may find that Windows® Explorer displays some file formats but not all types. This usually occurs if you have
had another file management program such as the Embird Iconizer installed. The issue may be that entries have
been made in the computer’s Registry that do not have an owner, and therefore cannot be updated by the
PREMIER+™ 2 Windows® Explorer Plug-in installation.

1. Download the VSM 6D Explorer Plugin Fix utility.
2. Double click on the VSM6DExplorerPluginFix.exe file.




3. You may receive a message asking “Do you want to allow the follow program to make changes to this
computer?” Click Yes.

4. A black screen will appear — when it is finished press any key to close that window.

5. Restart your computer.

6. Delete the Thumbnail cache (instructions in EP002).

The thumbnails for your stitch files should now be showing correctly.

! User Account Control

%) Doyouwantto allow the following program to make

&/ changes to this computer?

B 1 Program narme:  VSM 60 Explorer Plugin Fix
Verified publisher: VSM Software Ltd

File origin: Downloaded from the Internet

(%) Shaw details ves || Ne |

Change when these naotifications appear

FT011 "The selected dimensions will produce a large PhotoStitch and stitch
creation may take some time. Removing background areas will reduce the time
required.”

This message will appear if you specify a PhotoStitch larger than 26,000mm square. Click OK to continue
creating the PhotoStitch. To reduce the stitch creation time, remove the picture background, particularly any very
detailed areas. Stitch creation time is shorter for Linear PhotoStitch.

FT032 | have increased the Gap setting, but the lowercase characters are still
touching each other

For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script fonts use a special
‘continuous' joining method, which places lowercase characters adjacent to each other to give the appearance of
handwriting. All the fonts in the Script category use this joining method, and you may also create new fonts with
the PREMIER+™ 2 QuickFont Wizard or the optional PREMIER+™ 2 Font Create module that use this joining
method.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.



GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA008 "Embroidery XY coordinates incorrect”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension”

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

» User.sqlite
o System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.



GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA018 | can't see some of the floating toolbars or icons

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA019 "The color xx has been found in your database, but the thread color is not
exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.



To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA028 The toolbar icons have unexpectedly changed to a smaller size.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings
(see GAQ18).

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

GA036 \When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.



6. Follow the on-screen instructions.

GA049 When | double click on my stitch files, they now open in another software.
How can | reset the file associations?

It may be that you installed another software which is now associated with your stitch files.
To reset the association back to the PREMIER+™ 2 Embroidery System do the following steps:

. Close down all programs.

. Open PREMIER+™ 2 Configure.

. Click the Reset File Association button. A Reset File Association box will appear.
. Click on the PREMIER+™ 2 Embroidery button in the Reset File Association box.
. The Set Program Association page will appear.

. Click on the Select All checkbox. All stitch formats will be selected in the list.

. Click Save.

All the selected stitch formats will have been set back to open in PREMIER+™ 2 Embroidery.
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GA050 "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close the PREMIER+™ 2 module, follow the manufacturer's instructions for the WIA-compliant device,
then reopen the PREMIER+™ 2 module and try again.

GA051 "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the WIA-compliant device. Close the PREMIER+™ 2 module and the other graphics
program, then reopen the PREMIER+™ 2 module and try again.

GA052 Error message "Your scanner or camera is no longer available for use.
Close this program, plug in and switch on your scanner or camera, and run this
program again."

This message will appear if the connection to your scanner or digital camera has a problem. Close the

PREMIER+™ 2 module, check the connections to your scanner or digital camera, then reopen the PREMIER+™
2 module and try again.

GA053 Error message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close the PREMIER+™ 2 module, check the
connections to your scanner or digital camera, then reopen the PREMIER+™ 2 module and try again.

GA054 "Error. This scanned image type is not supported.”

This message will appear if the scanner has created an image file that is not supported by the PREMIER+™ 2
module. Convert the image to a supported image file format.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.



You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?



You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GEQ30
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

o Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
» Add info@embroiderynewsletter.net to your email Contacts or Address Book.

« Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
« Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.



3. In the Name and E-mail Address page, click Main Menu at the bottom left.
4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.
6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error;: ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.




2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions
4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format’. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
IOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:



When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Configure

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...eftc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

To view an embroidery within a compressed (zipped) file, browse into the compressed file in Explorer, open the
Preview pane, and click to view the selected embroidery.

You can move your activation to another computer.

In the Utilities page of PREMIER+™ 2 Configure click the Activate button and sign in to your Registration
account.

1. On the Enter Your Product Activation Codes page click 'l would like to remove my Activation from this
computer'.

2. Click OK to remove the activation from the computer.

You will then be able to install and activate your software on another computer.
Your activation code is in your registration entry.



cT009 | have a design with My Thread colors that are unmodified copies from
the Standard Thread Database, but they are not in my My Thread database.

If you open a file that has colors from a My Thread database that are unmodified copies of standard threads, but
do not exist as copies in your My Thread database, the color is identified and selected in the original thread range
when you click the color to change it.

cT1022 How do | make a backup of my personal threads?

To make a backup of a single thread database, use Export Threads to Embroidery in PREMIER+™ 2 Thread
Cache.

To backup all of your thread databases for moving to a new computer, use Backup MySettings in PREMIER+™ 2
Configure.

EC001 "The design can only be saved and stitched out if it is rotated 90 degrees.
|s that OK?"

This message will appear if the embroidery you are attempting to load is more than 260mm wide, but would fit if it
was rotated; that is it is between 260mm and 360mm wide, and less than 260mm high. Click Yes to continue.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

. Start PREMIER+™ 2 Configure.

. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

. Position the pointer over the icon in the system tray and right-click. A menu will appear.

. Click the Start Automatically option.

. Right-click the icon again to confirm the Start Automatically option is checked.

. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.
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EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EP001 No design thumbnails are shown, just an icon for the format type.



There is an option in Windows Explorer to turn off thumbnails, you may have this option turned on.

1. Open Windows Explorer.

2. Click on the Options box to open the Folder Options dialog.

3. Click on the View tab.

4. Uncheck the checkmark against the "Always show icons, never thumbnails" option.
5. Click OK.
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EP002 My thumbnails of designs look strange in the Windows Explorer.

It could be that you have had a previous software on your computer which had shown thumbnails of stitch files.
The cache of thumbnails needs to be cleared from Windows Explorer, so that it can start using the thumbnails
shown by the Windows Explorer Plug-in.

An example of the issue can be seen below, with the incorrect thumbnail image from a third party icon software
on the left; and the correct preview on the right:
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Another example of strange thumbnail image display, is if one of the thumbnails shows with a black background. It
will also be a smaller version of the design in the center of the thumbnail.

B

Cat Head.vp3 Caton its Cat Sitting.vp3
Back.vp3

Clear the Thumbnail Cache to fix both types of thumbnail display issues:
Windows 10/ Windows 8

1. Open Windows Explorer — right click the Windows Explorer icon on the Task bar and select File
Explorer.

2. Windows Explorer will open to the Quick Access/Libraries folder of your computer. In the left hand pane
of the window, click on the This PC/Computer heading.

3. Right click on the Local Disk (C:) entry, then click Properties. The Local Disk (C:) Properties dialog box
will appear.

4. On the General tab, click the Disk Cleanup button. It may take a few moments while the utility analyses
the drive.

5. Uncheck everything in the list, and then place a checkmark against the Thumbnails entry at the bottom.

6. Click OK and a confirmation message will appear. Click the Delete Files button.

7. Repeat steps #3 to #6 for any other Local Disk entries that you may have in Windows Explorer.
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Windows 7

1. Click on the Start menu.

2. Click on the Computer option. Windows Explorer will open.

3. Right click on the Local Disk (C:) entry, then click Properties. The Local Disk (C:) Properties dialog box
will appear.

4. On the General tab, click the Disk Cleanup button. It may take a few moments while the utility analyses
the drive.

5. Uncheck everything in the list, and then place a checkmark against the Thumbnails entry at the bottom.
6. Click OK

EP003 When | search for designs in Windows Explorer no designs appears.

This could be because you have the Windows Search option turned off.
To turn it on:
Windows 8

1. Go to your Start screen.

2. Type windows features

3. Click on the Turn Windows Features On or Off option.
4. Scroll down to the Windows Search option.

5. Place a checkmark in the checkbox if it is empty.

6. Click OK.

Windows 7

1. Click on the Start menu

2. Type windows features

3. Click on the Turn Windows Features On or Off option.
4. Scroll down to the Windows Search option.

5. Place a checkmark in the checkbox if it is empty.

6. Click OK.

EP004 \When | search for Properties of designs in Windows Explorer nothing
appears.

It could be that the Windows Indexing has been turned off; turn it back on and try again.
Windows 8
1. Go to your Start screen.



. Type services

. Click on the Services option that appears to open the Services box.

. Scroll down to the Windows Search checkbox.

. Right click on it.

. Select Properties

. On the General tab, ensure that you have the Automatic (Delay Start) selected.
. Click OK.

. Restart your computer.

10. Now try searching for a designs properties again.

Windows 7

. Click on the Start menu.

. Type services

. Click on the Services option that appears to open the Services box.

. Scroll down to the Windows Search checkbox.

. Right click on it.

. Select Properties

. On the General tab, ensure that you have the Automatic (Delay Start) selected.
. Click OK.

. Restart your computer.

. Now try searching for a designs properties again.

O©CoONOOOPWN

QOO NOOPA~,WN =

—_—

If you have your thumbnail view in Windows® Explorer set to Small icons, List or Details then you will not see
the preview - you will only see the Premier+™ l|ogo.

Change the View to one of the other available options to see the thumbnail images of your stitch files
Changing the View:

1. Open Windows® Explorer.

2. Browse to a folder that contains stitch files.

3. Right click on an empty area of main part of the Windows® Explorer screen.

4. Move your mouse over the View option.

5. Click on Medium icons - or whichever other option you prefer to view your thumbnail images in.

View v Extra large icons
Sort by b Large icons
Group by 3 | L | Medium icons L}
Refresh Small icons
Customize this folder... L

Details
Pas J
[ Tiles
Faste shortcut

Content
Undo Move Ctri+Z g
Share with 4
Mew 3
Properties

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its



format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created
Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has

more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
» System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA018 | can't see some of the floating toolbars or icons



Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. Amessage will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. Amessage will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed



Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE003 "Motif database is missing or corrupt. Cannot change motif."

This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb' from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

GE025 In Windows® 10, when | click Reset File Association in PREMIER+™ 2
Configure, a Windows® message appears.

In Windows® 10, you will need to manually reset the file association:

. Click on the Start menu in the bottom left corner of your screen.

. Click on Settings. The Settings window will appear.

. Click on the System button.

. Click on the Default apps entry on the left hand pane.

. Scroll to the bottom of the right hand pane.

. Click on the Set defaults by app link. The Set Default Program window will appear.

. Click on the PREMIER+™ 2 Embroidery entry from the left hand pane.

. Click on the Choose defaults for this program link on the right hand pane.

. Place a checkmark in the Select All checkbox - this will place a checkmark in all checkboxes if they were
not already checked.

. Click Save. This will associate all the available stitch formats from step #9 with PREMIER+™ 2
Embroidery.
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Click the Windows 10 Reset File Association link to see a video of the above process.

GE026 Feature not available in this version.



This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE028 How can | export an embroidery to a floppy disk?

You can use Export to save an embroidery to a floppy disk for a Husqvarna Viking Designer | sewing machine.

In the Export dialog, select Husgvarna Viking Designer | (.shv), then select the Floppy Disk tab below. If desired,
use Format Drive to format the disk before saving.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when itis in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net



GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GEQ30
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
Add info@embroiderynewsletter.net to your email Contacts or Address Book.

Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:



1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error;: ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN020 Error: "The program can't start because api-ms-win-crt-runtime-11-1-0.dll is
missing from your computer. Try reinstalling the program to fix this problem."



This error message appears when some Windows update files are absent from a computer with Windows 7 or
Windows 8. Use Windows Update to ensure that all updates have been installed.

This may take quite a long time, and involve restarting your computer several times.

To check which updates have been installed, search for "Windows Update" on your computer, and in the pane on
the left of Windows Update, select View Update History. Check that updates have been installed recently, and that
all updates are marked as Successful in the Status column. Use the troubleshooting instructions to install any
missing updates.

Error HO007 may be seen after you have updated. For more information, see INO21.

IN021 Error: "HOOQO7 Sentinel key not found"

This error message may appear during activation. Use the HO007 fixer utility to correct the problem.

1. Download the utility Error HO0O7 fix.

2. Double click on the Premier+2_H0007_Fixer.exe file
3. Follow the on-screen instructions

4. Open the PREMIER+™ 2 Embroidery software.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

Pco01 Invalid credit card number (pre-validation)

You have entered an invalid credit card number. Correct the number and try again.

Pco02 Error: You must accept the Terms and Conditions before continuing

You have not selected (checked) the box accepting the Terms and Conditions. Check this box and try again.
Now you will be able to continue in the Embroidery Purchase Center.

PC003 The expiration date has passed

The expiration date that you selected from the drop-down list is in the past. Either you selected the wrong date, or
your credit card is out of date.

PCcoo4 One or more required fields are missing

This will appear in the Payment Details page if at least one of the required fields is empty. This could happen if
your billing address and delivery address were not the same, and you had clicked Next before adding the
changed details.

PC005 The payment was accepted but an unexpected error prevented the
process completing. Please contact embroidery software support for more
information.



Something is wrong with your registration, so the Product Activation Code could not be added to it. Contact
embroidery software support for a diagnosis of the problem.

wso008 Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso011 How do | view the PREMIER+™ 2 online documentation on my Apple
iIOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:



When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Create

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco16 How do | backup my PREMIER+™ 2 settings?

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...eftc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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cco18 How can | view embroideries within zipped files?

To view an embroidery within a compressed (zipped) file, browse into the compressed file in Explorer, open the
Preview pane, and click to view the selected embroidery.

CsS006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

Dcoo1 \What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

Dco03 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.



Dcoo4 The background picture shows more of the picture than | want to use.

In the Paint window select the part of the picture you want with Box or Freehand Select then Crop the picture (you
can only do this before you start creating your design).

Dco05 The background image has a thick outline so that QuickStitch™ leaves
gaps between color areas

Use the Outline Thinner to narrow the outline to one pixel. This will allow areas to join together better.
To use the Outline Thinner:

1. Click on the Effects drop-down list on the Paint tab.

2. Click on the Cleaning option from that list. The Cleaning Effects dialog should appear.
3. Choose the options in the Outlinesection to get the results that you desire.

4. Click OK.

DC007 The size of my embroidery in the Life View dialog box is bigger than the
height or width | entered

The design size is set according to the distance between the two outermost control points of the design. The
stitches created from the design may go beyond these control points, so the size of the actual embroidery may
exceed the height or width specified for the design size.

Dcoo8s When | create stitches one of my fill areas doesn't fill completely with
stitches

Try changing the angle of orientation. Even one degree can be enough to allow the artificial intelligence of the
program to fill the object. Another possibility is to move the start point slightly.

Dcoo9 The fill shape created with QuickStitch when | click inside the area is not
the one | want

The pictures used should have well differentiated color areas, which may be solid or stippled, to fill easily. Clip art
is excellent for this purpose. If there is a gap where the same color flows into another area, the fill will not work as
expected.

If Color Tolerance is switched off then switch it on in File menu -> Preferences. Color Tolerance will then allow you
to preview any area for QuickStitch functions, which should reveal any problems with color areas in the picture.
You can then alter the picture in the Picture window. Alternatively, use the Create Area or Line function on the
Freehand Create or Precise Create tabs to manually create the Fill Area.

Dco10 How do | change the color of the border of my fill area?

To change the color of the border:

1. Create the fill area using QuickStitch, QuickStitch + AutoHole on the Quick Create tab - or the Create
Area or Line from the Freehand Create or Precise Create tab.

2. Right click on the new Pattern Fill area in the work area. The Fill Area and Line dialog box will appear.

3. Click on the Line tab.

4. Place a checkmark in the Insert Color Change checkbox.

5. Edit the Line Thread Change to your preferred thread color.

6. Click OK.



Dco11 | have only selected part of the Picture with the Design Area but
QuickStitch is going outside the Design Area

If you have an area of color that is both inside and outside the Design Area then QuickStitch will fill the whole
color area with stitches.
Do one of the following:

» Edit the Picture with the Picture window to reduce the size of the color area.
» Use Create Area or Line on the Freehand Create or Precise Create tabs to fill only the parts you want.
» Edit the QuickStitch area on the Edit window so that the fill area falls inside the Design Area.

Dc012 A QuickStitch™ border has a double layer of stitching in one section

If border areas run into each other, two layers of stitching will be produced by the QuickStitch™ border functions.
To avoid this, split the colors on the picture in the picture window, or another graphics package, e.g. put a visual
'end point' for each border area. Alternatively, use the Satin Line Trace function.

Dco16 | am Inserting new objects but they are using the last thread color |
selected, instead of the thread color that they should have, at the place where |
am inserting

This is a temporary effect that lasts only until you have finished inserting, that is when you switch back to Add or
go to the Edit or Picture window. If you insert a Color Change then the objects inserted after the Color Change will
use the new color as usual. The objects before the Color Change will revert back to the correct color when you
switch back to Add.

Dc021 Error "Design File is read-only. Cannot continue."

This will happen if you attempt to open a design that has been set as read-only, or is read-only because it is
stored on a CD-ROM. If the design file is on your hard disk as read-only then you must change its properties in
Windows® Explorer so that it is no longer read-only. For designs on CD-ROMs, use Windows® Explorer to copy
them to your hard disk, then change the properties so that they are no longer read-only. (Windows® Explorer
Help has information on the read-only attribute.)

DC022 Error "You must select an area first, before applying the crop tool."

Use the Box Select feature to select an area of the Picture around which you wish to crop the background.

Dco023 Error "Cannot rotate - picture will be bigger than 2000 x 2000 pixels if
rotated to this extent.”

When rotating a picture, certain angles could make the picture larger than the maximum allowed. If this message
appears, either rotate the picture to a different angle, or reduce the size of the picture, then try again.

DC024 Error "This is not an appropriate use of this tool. Areas of the image may
be too wide."

This happens when you use QuickTrace to follow an outline in the picture and then QuickTrace finds a part of the
outline that is very thick. This can be caused by excessively broad outlines or by selecting too much of the picture
with a high Color Tolerance value. In this case, QuickTrace does not know where to trace the outline as the
problem part of the outline is more like a fill area. Use a lower Color Tolerance value, or use the editing functions
in the Picture window to make the outline thinner or break up the outline so that the wide parts are isolated from
the rest of the outline.



Dco26 Error "Fill object is too complicated."

This message may appear if a QuickStitch™, Precise or Freehand fill area is too complex for the stitch generation
functions, usually because the fill area is very small. This may happen, for example, if a design has small areas
and is then further reduced in size.

To help find the area, check the progress bar that appears when stitches are created. This shows how far through
the design the object is, and can be used as an approximate guide for setting the slider bars on the Edit tab. If
desired, also use the filters to hide other object types. Use the FilmStrip to step through the objects quickly. Look
for small areas in the remaining visible objects, and adjust as necessary.

DC028 "Scanner or camera is in use by another application"

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the WIA-compliant device. Close PREMIER+™ 2 Create and the other graphics
programs, then reopen PREMIER+™ 2 Create and try again.

DC029 The border shape created with QuickStitch/QuickStitch +
AutoHole/Appliqué when | click inside the area is not the one | want

Use Color Tolerance to preview the area that will be used.

» Solid Colors. A solid color area must have well defined edges, either by having an outline of a different color
or by being enclosed by other colors. Color Tolerance will show where there are gaps in a border around an
area. If the area is not sufficiently well defined, alter the image in the Picture window, or another graphics
package, so that the area is enclosed.

« Stippled Colors. Stippled colors (also called 'dithered’ colors) are treated the same as solid color areas.

» Graduated Colors. If Color Tolerance is switched off then you will only be able to select a small, single
colored part of a graduated color. It is also easier to select a graduated color area when it is enclosed by
contrasting colors.

Color Tolerance is switched on with the Color Tolerance option in Preferences.
Alternatively, use the relevant functions on the Freehand Create or Precise Create tabs.

Dco33 Tips on using the Outline Thinner tool

It is important where you click after selecting the Outline Thinner tool. The color you click on is the color that will
be thinned. So if you click on a black outline, this outline will be thinned. Alternatively if you click on an area (such
as white on a black and white drawing), this area will be thinned and the outline around it will be thickened to
compensate. This leaves the drawing indistinguishable from the original.

The Outline Thinner tool may not work if your picture has dithering, such as a scanned image or one that has
been converted from a JPEG file. These pictures have additional colored pixels that can affect the result.

Dco35 Error message "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close PREMIER+™ 2 Create, follow the manufacturer's instructions for the WIA-compliant device, then
reopen PREMIER+™ 2 Create and try again.

DC036 Error message "Your scanner or camera is no longer available for use.
Close this program, plug in and switch on your scanner or camera, and run this
program again."

This message will appear if the connection to your scanner or digital camera has a problem. Close PREMIER+™

2 Create, check the connections to your scanner or digital camera, then reopen PREMIER+™ 2 Create and try
again.



DC037 Error message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close PREMIER+™ 2 Create, check the connections to
your scanner or digital camera, then reopen PREMIER+™ 2 Create and try again.

Dco38 "Could not load picture file."

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a USB stick, then closed and the USB stick removed. It could also appear if the file you are
attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a proper
picture file.

DC039 Error message "Not enough memory to save undo data."

This message may appear if you are using a large picture and your computer's memory or hard disk space is
relatively low. Close other programs and try again.

Dco42 "Filename already exists. Do you want to replace it?"

This happens when you are doing a Save As on the .edo design outline file and you have given the name of a file
that is already there. It also happens when you are saving a stitch file and the file already exists. Click Yes or No
as appropriate. You may have to replace a stitch file several times if you are creating stitch files to stitch out tests
of your design.

Dco44 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select RGB values 100, 102, 153 from the standard color dropdown on the Grid Color button.

Use Size setting on the View tab to change the grid spacing. Set the Grid Size to 10.

Dco47 My scanner or digital camera is not shown when | try to Select Source, or
the Select Source button is grayed out

The manufacturer of a TWAIN device must provide a Source Manager and a TWAIN Data source for your device
to work with Premier+ Create. These will normally be installed when you install the software and drivers provided
with the device. If you have installed a device and it is not shown in the list then it may not be TWAIN compliant.
Refer to the device documentation and manufacturer for assistance.

DC048 | am trying to Resize an area, but nothing happens when I click the
Resize icon or select Resize from the Picture menu

To resize when part of a picture is selected, simply click and drag any of the resize handles on the selection box
(out to increase size, in to decrease size). When the mouse is over a resize handle on a corner of the selection
box, the pointer changes from an arrow to the resize pointer.

DC049 | am trying to Rotate an area, but nothing happens when | click the Rotate
icon or select Rotate from the Picture menu

To rotate when part of a picture is selected, simply click and drag the round rotate handle on the middle right of
the selection box. Click and drag down to rotate clockwise, up to rotate counterclockwise.



DCco50 The Expander did not expand all my lines

The Expander makes lines thicker around areas in the picture that match the background color. The Expander is
intended for use with scanned pictures, such as line art that has been converted to monochrome and despeckled
to clean it up.

DC051 Some of the satin sections in my imported or inserted embroidery are
now fill areas

Some wide areas of satin may be imported as fill areas, depending on their size in the embroidery. This is
because any area that is very wide is assumed to be a fill area. Also, all satin sections that have a fill pattern will
be imported as fill areas.

DC052 | have loaded a design that uses a My Fill pattern, but the fill area is
showing a plain pattern

This will happen if you delete a pattern from your My Fill database and then load a design that uses the pattern.
The pattern will use system pattern 3 instead of the deleted My Fill pattern. Either import the deleted pattern
picture again, then select it in the My Patterns area of Fill Properties, or choose a different pattern.

DC053 | have a design from a friend and the My Fill pattern for a fill area is
different on my computer

When you have a design from somebody else that contains a fill area with a My Fill pattern, it is likely that their
MyFill database will have different patterns to your My Fill database. You must obtain the exported My Fill pattern
and import it into your My Fill database, then select the correct pattern in the My Patterns area of Fill Properties.

DCo054 Stepping through the pages of MyFill patterns is very slow on my
computer

This may happen on slower computers if you have created a lot of very large MyFill patterns, and also if you have
created and then deleted a lot of MyFill patterns.

It may help if you backup and then restore the MyFills database using the Backup MySettings and Restore
MySettings options in PREMIER+™ 2 Configure. When you restore MySettings, the MyFills database size will be
optimized which may help improve the speed for selecting MyFills.

Dco55 When | use motif fill areas, the design takes a long time to appear on the
Design window

On slower computers, large or complex motif fill areas may take some time to draw, particularly if there are holes
in the area. This may be noticeable when you create new motif fill areas and when you return to the Design
window from the Paint or Draw window, or another PREMIER+™ 2 Embroidery System module.

DC057 | have inserted a new point and moved an outline but there is still an
outline in the old position

Some functions in the Quick Create tab create more than one outline at a time, such as, Double and Quadruple
Trace. For example, Quadruple Trace puts lines of triple and running stitches directly on top of each other. This
means that if you want to add and move a new point to change a Quadruple Trace then you will have to do so
twice, once for each of the lines.



DCo058 | have pasted a block but it is not the original color

A color change is only copied when it is part of the selected block. If you paste a block that does not start with a
color change then it will use the color that is active at the point where the block is pasted. If you want to preserve
the color, either copy the relevant color change or use the FilmStrip to insert the desired color.

Dco61 | did not select all the objects | wanted with Box, Freehand Point or
Freehand Select

Objects must be fully enclosed by the selection line to be selected as part of a block. If even the smallest part of
an object is outside the line then it will not be selected.

DCo64 | have created a satin line with Satin Line Trace but | can't change the
width of it all at once

Use the FilmStrip and/or slider bars to hide all objects except the satin borders and traveling running stitch used
to create the trace. Select any Satin Line objects in the trace, then right-click in the FilmStrip and select Global
Properties. The Satin Line properties dialog box will appear. Make adjustments as desired and click OK. The new
properties will be applied to all visible satin borders.

Alternatively, if working within a group, use Select Similar from Group to apply the settings to all other objects of
the same stitch type within the group.

Dcoe5 Color Tolerance does not show me all the lines that will be traced by a
Trace function

The dashed line used by Color Tolerance only shows the outside of the area that is selected by the current Color
Tolerance value. Simply try the Trace function and if the result is not satisfactory then Undo the result and retry
the trace with a higher Color Tolerance.

Dcoeé There is no underlay under a fill area

Underlay is set to none when you select Gradient or Multi-Gradient Density for a pattern fill area. This is because
the underlay stitching will spoil the effect of Gradient or Multi-Gradient Density. If you change an area from
gradient density to Standard density, reset the Underlay if desired.

Dco67 The Gradient or Multi-Gradient Density on my fill area does not change
very smoothly

If you have a fill area with a complex outline then this may cause the stitches to fill unevenly when you select
Gradient or Multi-Gradient density. This is because of the way that the edge of the area interferes with the ideal
spacing of the stitches.

Gradient and Multi-Gradient density work best for areas with straight or smoothly curving sides. You could replace
the Fill Area using Create Area or Line from the Freehand Create or Precise Create tabs, or edit the area to
straighten the side that causes the uneven stitches.

Dcoe8 What is the best picture size to load for creating a design?

The best size for a background picture is approximately 1000x1000 pixels (or greater). When using pictures
significantly smaller than this PREMIER+™ 2 Create will magnify it, but lines may appear jagged rather than
smooth. For example, if a picture is loaded that is less than 500 pixels in both height and width it will automatically
be doubled in size. The best way to produce a smooth effect is to rescan the picture.



The QuickStitch features use defined color areas to place fill areas, motif fill areas and borders. However, the
Color Tolerance function allows you to merge different color shades to change the size of this area. The filters
may also be useful to create color areas. For example, use the Despeckle filter to remove small spots of color that
are often found on scanned pictures. Also, some scanned or clip art pictures have thick outlines so there may be
gaps between the areas that are larger than desired. Use the Outline Thinner to reduce the thickness of outlines
to one pixel automatically.

If there is a gap where the same color flows into another area, some of the functions on the QuickStitch tab will
not work. Because gaps in a picture are often not very large, a good way to check whether a picture is suitable is
to test whether the areas will flood fill and 'patch them up' as necessary.

How To Use

1. Click the Picture tab at the top of the screen.

2. Use Flood Fill to fill an area with the foreground color. If it does not have complete outlines, more of the
picture will be flood filled than expected.

. Click Undo.

. Select the foreground color to be the same as the outline around the area.

. Click Freehand Draw and select the third line thickness.

. Zoom In to the outline to find the gaps, then draw lines to fill any gaps in the outline.

. Select another color and test the fill again. When only the expected area is flood filled, the picture is ready
for the QuickStitch functions.
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If the control panel is 'floating' on top of the window, double-click the title bar and the control panel will move back
to its original position.

If the control panel is docked on the wrong side of the window, click and drag the title bar to the middle of the
right-hand edge of the window until the outline snaps into position on the right. Release the mouse button and the
control panel will be dropped into its original position.

If this does not work, or the control panel is not visible, use Reset All Modules.

Note that Reset All Modules affects all modules in the PREMIER+™ 2 Embroidery System, so any changes to
settings in each module will be reset. The recent files list on the File menu is also cleared, but this does not affect
any files you have saved.

To use Reset All Modules:

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. Amessage will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The next time you start
PREMIER+™ 2 Create, the control panel will be in the correct position.
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This message appears if a .can file cannot be loaded. For example, it might have the extension .can, yet not be a
proper design outline file.



DCc074 "Cannot save file."

The program cannot save the file. Ensure that the disk where you are trying to save the design is not write-
protected, then try again.

DC075 Some of the icons in the Toolbar are 'grayed out'.

Certain icons (for example Break Apart on the Edit ribbon tab) are only highlighted once a design is shown on the
screen. Also, when there is a design on the screen, some functions that might cause a mismatch between the
size of the design and the size of the picture are not available in the Picture window.

DCo76 | have moved the Design panel, and | can't put it back in position.
If the Design panel is 'floating' on top of the window, double-click the title bar and the panel will move back to its
original position.

If the Design panel is docked on the wrong side of the window, click and drag the title bar to the middle of the
right-hand edge of the window until the outline snaps into position on the right. Release the mouse button and the
Design panel will be dropped into its original position.

Using Reset All Modules in PREMIER+™ 2 Configure will also return the Design panel to its original position.

Dco77 | am looking for the origin of my fill area, but there is no orange circle.

The origin is usually shown as an orange circle. It may be a different color, depending the underlying picture or
background colors. Also, the origin can be moved anywhere on the work area. Try Zoom To Fit to see the whole
work area.

DC080 The preview picture is blank or almost blank on the Express Trace
Options or Express Border Options page.

This may happen if the outlines in the picture are only one pixel wide after the Monochrome Threshold page.

For Express Trace, return to the Outline Finder and Expander page, select Find Outlines and ensure Expand is
setto 1.

For Express Border, first click Picture Options in the Express Border Options page and set the Area Sensitivity to
High. If this does not have the desired effect, return to the Monochrome Threshold page and adjust the slider so
that more of the picture within the desired areas turns black. If this also selects unwanted parts of the picture, you
may need to remove the unwanted areas in a picture editor.

To remove unwanted areas, use the Open Picture function in the Paint Window to open the picture. Set the
background color to white. Select unwanted areas with Box Select or Freehand Select and Delete them. Use
Save As Picture to save the picture with a new name, in case you wish to make further edits, then click Send To
Wizard.

Dcos82 More of the picture than | want is selected for functions on the QuickStitch

tab when | click inside a small color area.
QuickStitch will not create an area from part of the picture that is very small or very thin. This is because the area
will either have insignificantly few stitches, or it is not wide enough for stitches to go across it. Try editing your

picture to enlarge the area, so that it is big enough to be used as a Fill area from Quick Create tab. Alternatively,
use single or running stitches. For thin lines, use Trace from the Quick Create tab.

Dco84 \When | try to convert my area to a satin area, it does not seem to work.

If an area is too small or the outline of the area crosses itself, it may not always convert to a satin area. If the area
is very small, adjust the outline to increase the size of the area. If the outline of the area crosses itself, adjust the



outline to prevent this.

Dco85 Error: "Cannot load My Fills picture. The width and height must be
between 120 to 700 pixels."

This message appears if the picture being imported in the Manage My Fills function is outside the required size
range. Resize in an image editing program such as Windows® Paint.

Dcogse "Error. Unable to locate MyFills.mdb."
This message usually means that the My Fills database has been deleted or corrupted. This may be corrected by
first attempting to Restore MySettings.

To Restore MySettings, you must have previously saved a copy of MySettings with Backup MySettings. Click
Restore MySettings in PREMIER+™ 2 Configure and select the desired backup to restore. See the online help in
PREMIER+™ 2 Configure for more information.

If the error still appears, then repair the installation. First, delete the file named 'MyFills.mdb' from
ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'MyFills'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the My Fills database will be restored to its original installation state. This means that the My Fills
database will be empty. If you had any My Fills, you will need to import them again.

Dcos87 Error: "The start and end points do not line up. Add a stitch?"

This message may appear when exporting a drawing to My Motifs or as a Machine Stitch.

Motifs and machine stitches are usually designed to stitch from left to right, and to start and finish at the same
level. This function allows you to add a stitch to ensure the start and end points line up.

Dco88 Error: "To move a group of objects to the back of the design, the first
object must be a color change”

This message is displayed when Move to Back of Design is used to place an object other than a color change at
the beginning of a design. The first object in a design must always be a color change, or a group that starts with a
color change. Ensure that the first object in the selection to be moved is a color change.

DC089 Some of the icons in the Ribbon bar are 'grayed out'

Certain icons (for example Cut on the Home tab) are only highlighted once a design is shown on the screen. Also,
when there is a design on the screen, some functions that might cause a mismatch between the size of the
design and the size of the picture are not available in the Picture window.

DC090 | have loaded a picture with the ExpressDesign Wizard, and changed it
on the Paint window. Now | want to use Send To Wizard, but it is not available.

Send To Wizard may not be used when there are objects in the design.

When you use the Load a Picture into the Paint Window option in the ExpressDesign Wizard, the design area is
also automatically created, so that you can begin to create your design when the wizard finishes. To make Send
To Wizard available, click the Edit tab, click Display All Objects, then in the Home tab click Select All Visible, then
click Cut. This will remove all objects in the design. Click the Paint tab, then click Send To Wizard.



After you have made changes to your picture, it is recommended to use Save As Picture to save the modified
picture with a new name, before using Send To Wizard.

Dc091 Why can'’t | click Finish on the Fabric and Stitch Type Options page?

If you change the options on the Fabric and Stitch Type Options wizard page, you must click Refresh Preview
before you can click Finish to place the embroidery in the work area. The Finish button is not available until the
preview has been refreshed.

DC092 | am trying to change colors for some objects but they don’t appear on the
color worksheet in the Design Panel

Colors for multicolor gradient density are only visible when Design Property Colors is selected in the Design
Panel. Select Design Property Colors to see the colors, and change them there, or by selecting the pattern fill
area and changing its properties. Similarly, the border color for a fill plus border area can be edited on the color
worksheet or on the line tab in the properties box.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

. Start PREMIER+™ 2 Configure.

. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

. Position the pointer over the icon in the system tray and right-click. A menu will appear.

. Click the Start Automatically option.

. Right-click the icon again to confirm the Start Automatically option is checked.

. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.
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EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

ED001 "Some areas were too thick to be traced."

This message may appear when creating an Express Trace design if the final picture has thick areas of solid
color. Some or all parts of the design may not be created. Try using options in the wizard, on the Outline Finder
and Expander page and/or the Monochrome Threshold page, to ensure the outlines are not too thick. Cancel the
wizard, adjust the picture so that the outlines are easier to isolate with Monochrome Threshold, then open the
picture in the ExpressDesign Wizard again.

ED002 My picture already has outlines, but some outlines are not traced properly
when | create an Express Trace embroidery.
This can happen if the outlines in your original picture are only one pixel wide. For example, there may be gaps or

missing sections of the outline. If this happens, select Find Outlines on the Outline Finder and Expander page and
ensure Expand is set to 1. This will thicken all the outlines so that they are traced correctly.



ED003 My picture only makes a rectangular border when | create an Express
Border.

This can happen with a picture that has a border or background that is black or very dark, especially if the
background or border cannot be removed with Monochrome Threshold.

For pictures with a dark border, it should be possible to remove the border on the Crop Picture page of the
ExpressDesign Wizard. If this is not possible, edit the picture to remove the border or change the border color.

For pictures on a dark background, use an image editor to invert the colors in the picture or change the
background color to a light color.

After editing the picture, load it again in the ExpressDesign Wizard.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EmMo010 "Error. Font file is corrupt.”

This message appears when trying to select or use a lettering style if the file has corrupted. Reinstall the font.

This may also appear if a font is created in PREMIER+™ 2 Font Create and has no characters defined. Use
PREMIER+™ 2 Font Create to define at least one character in the font.

EM011 Error: "Embroidery is too large or not in the hoop"

This message appears if an embroidery you are trying to Export or Print is outside the selected hoop or larger
than will fit in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x
100mm might be placed partially outside the work area when you click Export or Print. This message would then
appear. Move the embroidery completely within the four blue corners of the work area and try again.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM073 "Error. Cannot open Font File."

This message appears if the font or SuperDesign set that you have selected is not available. The most likely
reason is that it is already open in the optional PREMIER+™ 2 Font Create module. Close PREMIER+™ 2 Font
Create, then try again.

This could also happen if you opened the PREMIER+™ 2 Embroidery program, then accidentally moved or
deleted the font from the relevant category folder in ProgramData\VSMSoftware\Premier+2\Fonts, or the
SuperDesign file from ProgramData\VSMSoftware\Premier+2\SuperDesigns. Close PREMIER+™ 2 Embroidery,
make sure the file is in the folder, then try again.



EM082 Could not load picture file.

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a USB memory stick, then closed and the memory stick removed. It could also appear if the file you
are attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a
proper picture file.

EM110 | would like to get rid of the stray stitches in the background of my
PhotoStitch embroidery

It is best to clean the background of a picture so that there are no flecks, as they can cause stray stitches. If some
remain in a saved PhotoStitch embroidery, remove them in the Modify tab or open the file in PREMIER+™ 2
Modify and use the following instructions.

1. Use one of the Select features to select the stray stitches.
2. Click Delete Stitches.
3. Save the adjusted embroidery.

EM111 In Font Manager one of the fonts in My Fonts shows a Minimum and
Maximum size of 0.0 mm.
In the Font Manager dialog box a font that was created in QuickFont Wizard in PREMIER+™ Embroidery or in

PREMIER+™ Font Create, and copied to your My Fonts folder, may show a minimum and maximum size of 0.0
mm. This does not affect the use of the font.

EM112 Send to Machine via mySewnet™ and PREMIER+™ 2 version 12.4 for
Windows®

The Send to Machine via mySewnet™ feature for sending designs to the HUSQVARNA VIKING Designer EPIC™
and the PFAFF creative icon™ is not currently working in PREMIER+™ 2 version 12.4 for Windows®. This issue
does not affect PREMIER+™ 2 version 12.4 for Mac®.

As a temporary workaround, you can use Send to mySewnet™ and then browse to the file on your machine.
A fix for this issue is being worked on.

FT016 Error "The color xx has been found in your database, but the thread color
is not exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

GA001 | can't drag and drop embroideries from the Open dialog box

To drag and drop embroideries onto the Work Area, open Windows® Explorer. Then follow the instructions under
Drag and Drop.



GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA008 "Embroidery XY coordinates incorrect"”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension”

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."



This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
o System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.



GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA032 "Please choose a valid motif pattern.”

This message appears if you try to select a motif from My Motifs, and all the motifs have been deleted from My
Motifs. Use PREMIER+™ 2 Create to add at least one motif to My Motifs.

GA034 "Error saving picture."

This message appears on attempting to save the picture and the picture is not saved. For example, if you attempt
to overwrite an existing picture that is read only or if you attempt to save the picture to a read only location such
as a CD-ROM.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.



GA046 When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA055 "Error. Shapes database is corrupt or missing."

This message usually means that the shape database has been accidentally moved, deleted or corrupted. This
may be corrected by repairing the installation.

This error does not prevent the PREMIER+™ 2 module from starting. However, you will not be able to use the
relevant functions until this is resolved.

To correct this, start the installation for your PREMIER+™ 2 Embroidery System software, then choose the Repair
option.

If the problem persists, delete the file named 'BorderShapes.bdr' from
ProgramData\VSMSoftware\Premier+2\System, and then use the Repair option again.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error.

Repair an Installation of the PREMIER+™ 2 Embroidery System

1. Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.)

2. When the choice appears, select the "Modify or remove" option and click Next.

3. In the next screen, select Repair and click Next.

4. Continue with the installation and follow the on-screen instructions.

When the installation is complete, the shapes database will be restored.

GA056 The From Scanner or Camera option is not available, even though my
scanner/camera is plugged in.

The From Scanner or Camera option may not be available, even though you have installed and connected a
scanner/camera, if it does not support Windows Image Acquisition (WIA). If your scanner/camera supports a
different image acquisition system, e.g. TWAIN, create a .png or .jpg file of the image in My Pictures, and load it
from there.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."



This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb’ from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.



GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
Add info@embroiderynewsletter.net to your email Contacts or Address Book.

Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.



GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

INo15 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.



IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
IOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:



Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Cross Stitcher

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.

O ~NO O p~

When stitching out an embroidery from PREMIER+™ 2 Cross Stitcher you are working on a grid of squares.
Unlike any other type of embroidery design, you cannot add compensation, or overlap objects to allow for pull of
the fabric.

If your fabric is not hooped up correctly, then gaps can appear between sections, sometimes making it appear
that that stitches are missing altogether. Use extra backing and ensure the fabric is tight in the hoop. Lowering the
number of cross threads and enlarging the cross size also helps.



cs002 Error message "Not enough memory to load this picture."

This message may appear if the picture is very large. If you are loading the picture, use picture editing software to
reduce it size. If you are acquiring the picture from a scanner or digital camera, change the settings in the
acquiring or scanning application so the picture is smaller.

Ccs003 Error message "Loadlmage: GDI+ out of memory."

This message could appear if the selected picture is not a valid picture file. For example, it might have an
extension such as .bmp or .jpg, yet not be a proper picture file.

Ccs004 Error message "Cannot open file "xx.krz". The device is not ready."

This message appears if the desired cross stitch design (.krz) file is not where the module expects it to be. For
example, if a design was loaded into the program from a USB drive, then closed and the USB drive removed. The
message would appear if you tried to load the design from the recent files list on the File menu.

Ccs005 Error message "No valid cross stitch data (Unknown file format)."

This message appears if the file you are attempting to load is corrupt. For example, it might have a .krz extension,
yet not be a proper cross stitch design file.

Ccs006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

cso007 "This will remove all stitches with this color. Do you wish to continue?"

This message appears when you click Delete Color in the Design Panel, if there are stitches using the selected
color in the cross stitch design. Click Yes to continue, for example, to remove a color that is only used in the
background.

CsS009 | have used a variegated thread, but it is only showing as a single color

Only the first color in a variegated thread is shown in a cross stitch design. To see the effect of a variegated
thread, use Design Player or Life View.

cso010 | have placed backstitch, but it is not visible at all zoom levels

If the grid color is similar to the color of backstitch, then the backstitch may blend with the grid at certain zoom
levels so that it is hard to see. Turn off the grid temporarily to see where you have placed your backstitch.
Backstitch may also be easier to see in Block mode.

Ccs014 | can't drag and drop designs from the Open dialog box

To drag and drop cross stitch designs onto the work area, open Windows Explorer. Then Drag and Drop the
design(s) into the work area.

Ccs015 | have loaded a picture for a new design, but Flood Fill covers the whole
picture when | try to fill colored areas of the picture



Pattern Flood Fill and Cross Flood Fill are not affected by areas of color in a background picture. An empty area
of the design can be flood filled until it meets existing crosses and backstitch. A connected area of the same
colored crosses can be flood filled until it meets an empty area, backstitch or crosses in a different color. To
clearly see the areas that will be flood filled, turn off the background picture.

cso16 Flood Fill does not fill the whole area as expected

In some cases, Pattern Flood Fill and Cross Flood Fill will not go through narrow areas. If the fill could not
continuously connect a fill of full crosses through a narrow gap, the gap will act as a barrier to flood fill.

CS017 | have a pattern that uses freehand backstitch. When | use it to fill an area
it does not seem to fill the area completely or some lines of freehand backstitch
appear to be missing.

When a pattern is used to fill an area, freehand backstitch in the pattern will only be placed when both end points
lie within the fill area. Long sections of freehand backstitch are less likely to have both ends in the fill area and
may not give the desired result. If you wish to use freehand backstitch in a pattern, try to use short sections where
possible.

cso18 When | use Rotate 90 on a selection, the selection becomes a square

The selection area is extended by Rotate 90 so that you can clearly see where the selection will be placed by
each click of the Rotate 90 icon. The stitches in the selection area are not changed.

cs019 Nothing seems to happen sometimes when | use Undo after using Erase

Each time you click with Erase, this is recorded as an action you can Undo. If you click in blank space, or you
miss the item you are trying to Erase, the action is still recorded for Undo. Hence, when you Undo, the Erase
action is undone, even though it seemed to have no effect on the design.

Ccs021 The embroidery is larger than the design size | had selected in Design
Properties

This may happen if you have French knots on the edges of your design. French knots are drawn by placing their
center point on any point that snaps to half grid spacing. Therefore, if they are placed along the edges of the
design, half the French knot will be outside the grid. If French knots are placed on all edges of the grid, the
resulting embroidery will be larger than the design by the size of a French knot.

French knots are only scaled in comparison to the full cross size when the Cross Size in Design Properties is set
between 2mm and 4mm. The French knots will not be any smaller or larger than they are at these limits.

CS022 The embroidery seems to have too many stitches

Check Design Properties to ensure you do not have a large number of strands for crosses and/or backstitch in the
design. Increasing the number of strands will increase the number of stitches.

Ccs023 The embroidery is very thick when it stitches out

Check Design Properties to ensure you do not have a large number of strands for crosses and/or backstitch in the
design. Increasing the number of strands will increase the density of stitches.

CcS024 There seem to be some very thick lines of stitching where | used
backstitch in the design



Standard Backstitch and Freehand Backstitch are drawn on two separate layers in PREMIER+™ 2 Cross
Stitcher, but they are stitched out together if they are the same color. In addition to this, Freehand Backstitch can
be placed in multiple layers over the same line, as long as the end points of each line are different.

This is used, for example, to place different colors of Freehand Backstitch on top of each other to secure the
edges of lace. Each layer will stitch out separately according to the color order in the design, but the same thread
color is used in the stitch-out to give a single color to the lace effect.

Ccs025 | have selected a character | have designed, but the Save Char button is
greyed out on the Letter tab

The Save Char button is not available if there are more than three colors in the palette. Use Remove Unused
Colors in Color Configuration to reduce the palette to the colors used to design the font.

cs026 | have saved all my characters, but when | try to use the font there is
nothing shown in the preview, and nothing appears on the design when | click

Apply

Use Configure Fixed Font on the File menu to check that you have set the Line Height and Baseline values
correctly. The Line Height should be the height of the 'A’, plus space above for accents on uppercase characters,
plus space below for descenders, plus at least one more grid square below for space between multiple lines of
text. The Baseline should be the amount of grid squares that is allowed for descenders. If the Baseline is set to
the same or greater than the Line Height, this may also cause nothing to appear when the font is used.

Ccs027 Stitches seem to be missing when | open my cross stitch designs after |
have been working for a while.

This will only happen if you have used Hide Colors to hide some of the colors or stitches in a design you were
working on previously. The Hide Colors options are not reset automatically until you restart PREMIER+™ 2 Cross
Stitcher. Ensure that all of the design colors can be seen.

Dcoo1 What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

DCo003 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.



6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM022 Some of the icons in the toolbar are 'grayed out'.

Certain icons (for example Save and Export on the Quick Access Toolbar) are only highlighted once an
embroidery is shown on the screen.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM112 Send to Machine via mySewnet™ and PREMIER+™ 2 version 12.4 for
Windows®

The Send to Machine via mySewnet™ feature for sending designs to the HUSQVARNA VIKING Designer EPIC™
and the PFAFF creative icon™ is not currently working in PREMIER+™ 2 version 12.4 for Windows®. This issue
does not affect PREMIER+™ 2 version 12.4 for Mac®.

As a temporary workaround, you can use Send to mySewnet™ and then browse to the file on your machine.
A fix for this issue is being worked on.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors



If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
» System_cdb2.sqlite



This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. Amessage will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. Amessage will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.



GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA036 When I try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.



GA056 The From Scanner or Camera option is not available, even though my
scanner/camera is plugged in.

The From Scanner or Camera option may not be available, even though you have installed and connected a
scanner/camera, if it does not support Windows Image Acquisition (WIA). If your scanner/camera supports a
different image acquisition system, e.g. TWAIN, create a .png or .jpg file of the image in My Pictures, and load it
from there.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.



This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
Add info@embroiderynewsletter.net to your email Contacts or Address Book.

Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)



2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".
4. Click Next to unsubscribe.

GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

INo15 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.



The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error;: ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format’. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.



Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Design Aligner

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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To view an embroidery within a compressed (zipped) file, browse into the compressed file in Explorer, open the
Preview pane, and click to view the selected embroidery.

CsS006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

DA001 Error: "Embroidery will not fit in hoop."

This message appears if you choose an embroidery that is too large for the multipart hoop you have chosen. This
may also appear if you try to load an embroidery that is larger than 2000mm high and/or wide. The embroidery
will not be loaded, and the preview area will be empty.

DA002 Error: "At least one side of the work area is more than 2000mm long.
Choose a different hoop size or increase the hoop overlap to make the area
smaller.”

This message appears if you click Finish in the Load Design Wizard, and the combination of embroidery size,
hoop size and overlap will make the work area more than 2000mm high and/or wide. You will not be able to Finish
the wizard until this is resolved.

If you wish to split the selected embroidery, click Back in the wizard and change either the hoop size or the
Overlap value. Increasing the overlap will bring hoop sections closer together, which will reduce the overall size of
the work area.

DA003 Error: "Your split line crosses back on itself."

This message appears when you attempt to use Split Design if you have looped a split line around so that it
crosses itself. The embroidery will not be split. Adjust the split line so that it no longer crosses itself.

DA004 Error: "Split lines cannot cross over each other more than once!"

If you have two or more hoop areas both across and down then you will have both vertical and horizontal split
lines.

Each horizontal split line will cross each vertical split line. While it is possible to adjust the lines so they cross
each other several times, this would cause ambiguous split zones that do not clearly belong to a particular split
section. When this is the case, this message appears when you attempt to use Split Design. Adjust the split lines
so that they only cross each other once.

DA005 Error: "Embroidery is too large or will not fit in hoop."

This message appears when you attempt to use Split Design and any part of the embroidery is outside the work
area. Move the embroidery so that it fits inside the work area, or use Hoop Preferences to make the work area
larger.

DA006 Error: "filename01 already exists. Do you want to replace it?"

This message may appear when you attempt to export the split embroidery sections, and you have already used
the filename to export split embroidery sections. Only the name of the first split section is shown.

Click Yes if you want to go ahead and replace the split sections with the same name. It is only recommended to
do this if the same number of split sections will be replaced.



Click No to cancel exporting the sections. You will need to use Split Design again. Export with a different name, or
choose a different folder to save in.

DA007 Error: "This design contains design information that would be fixed as
embroidery stitches; for example, Lettering or SuperDesigns. Do you wish to
continue?"

This message may appear if you open a .vp4 file containing lettering or SuperDesigns in PREMIER+™ 2 Design
Aligner, as they will be fixed as stitches. Save the embroidery under a new name if you want to keep a copy of the
original.

If desired, you can turn this message off in Preferences.

DA008 Error: "Split lines have been modified. Click OK to continue without using
Split Design. Click Cancel, then Split Design to use the adjusted split lines for the
current embroidery.”

This message appears if you click OK in Preferences after changing the hoop and/or overlap settings when the

existing adjustments to split lines have not been used. If you click OK, the new hoop and/or overlap settings will
be applied to the work area, but any adjustments to split lines will be lost.

DA009 Some of the icons in the toolbar are 'grayed out'

Certain toolbar icons (such as Undo before anything has been done) are only highlighted once an embroidery is
shown on the screen, or some other action has taken place.

DA010 | cannot move the decorations in my design

Decorations cannot be selected or moved in PREMIER+™ 2 Design Aligner. Decoration subdesigns will be split
automatically when the embroidery is split.

To move decorations, modify the design in PREMIER+™ 2 Embroidery Extra, save it, and then use PREMIER+™
2 Design Aligner to split the adjusted design.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.



However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM021 |t seems to take a long time to redraw embroideries when | choose
different functions or switch to a new embroidery

The refresh rate of the screen is limited by the power of your computer's processor and RAM as well as the video
card and its memory. To get the best performance from your system, try using 2D view as this requires less power
than 3D view.

EM022 Some of the icons in the toolbar are 'grayed out'.

Certain icons (for example Save and Export on the Quick Access Toolbar) are only highlighted once an
embroidery is shown on the screen.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

GA001 | can't drag and drop embroideries from the Open dialog box

To drag and drop embroideries onto the Work Area, open Windows® Explorer. Then follow the instructions under
Drag and Drop.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.



GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA008 "Embroidery XY coordinates incorrect”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
» System_cdb2.sqlite



This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA016 | wish to change the background color for the work area

Use PREMIER+™ 2 Configure to alter the background color for the work area. PREMIER+™ 2 Configure may
also be used to change the texture for modules that use texture.

GA018 | can't see some of the floating toolbars or icons

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. Amessage will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.



« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA028 The toolbar icons have unexpectedly changed to a smaller size.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings
(see GAQ18).

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:
1. Open PREMIER+™ 2 Configure.



2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA049 When | double click on my stitch files, they now open in another software.
How can | reset the file associations?

It may be that you installed another software which is now associated with your stitch files.
To reset the association back to the PREMIER+™ 2 Embroidery System do the following steps:

. Close down all programs.

. Open PREMIER+™ 2 Configure.

. Click the Reset File Association button. A Reset File Association box will appear.
. Click on the PREMIER+™ 2 Embroidery button in the Reset File Association box.
. The Set Program Association page will appear.

. Click on the Select All checkbox. All stitch formats will be selected in the list.

. Click Save.

All the selected stitch formats will have been set back to open in PREMIER+™ 2 Embroidery.
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GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the



OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?
You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GEQ30
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

» Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
« Add info@embroiderynewsletter.net to your email Contacts or Address Book.

» Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
» Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?



You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.
4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".
5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed



IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.



wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
iIOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Embroidery

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco16 How do | backup my PREMIER+™ 2 settings?

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

4. Open Windows Explorer.

5. Browse to your Documents folder.

6. Double click on the PREMIER+™ 2 Embroidery folder.



7. Copy all folders and files - except the Samples folder - to your *external media.
8. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 /| Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.

cco18 How can | view embroideries within zipped files?

To view an embroidery within a compressed (zipped) file, browse into the compressed file in Explorer, open the
Preview pane, and click to view the selected embroidery.

cc020 How can | move my activation to another computer?

You can move your activation to another computer.

In the Utilities page of PREMIER+™ 2 Configure click the Activate button and sign in to your Registration
account.

1. On the Enter Your Product Activation Codes page click 'l would like to remove my Activation from this
computer'.

2. Click OK to remove the activation from the computer.

You will then be able to install and activate your software on another computer.
Your activation code is in your registration entry.

cso006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

Dcoo1 What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

Dco03 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

EC001 "The design can only be saved and stitched out if it is rotated 90 degrees.
Is that OK?"

This message will appear if the embroidery you are attempting to load is more than 260mm wide, but would fit if it
was rotated; that is it is between 260mm and 360mm wide, and less than 260mm high. Click Yes to continue.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.



You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

ED001 "Some areas were too thick to be traced.”

This message may appear when creating an Express Trace design if the final picture has thick areas of solid
color. Some or all parts of the design may not be created. Try using options in the wizard, on the Outline Finder
and Expander page and/or the Monochrome Threshold page, to ensure the outlines are not too thick. Cancel the
wizard, adjust the picture so that the outlines are easier to isolate with Monochrome Threshold, then open the
picture in the ExpressDesign Wizard again.

ED002 My picture already has outlines, but some outlines are not traced properly
when | create an Express Trace embroidery.

This can happen if the outlines in your original picture are only one pixel wide. For example, there may be gaps or
missing sections of the outline. If this happens, select Find Outlines on the Outline Finder and Expander page and
ensure Expand is set to 1. This will thicken all the outlines so that they are traced correctly.

ED003 My picture only makes a rectangular border when | create an Express
Border.

This can happen with a picture that has a border or background that is black or very dark, especially if the
background or border cannot be removed with Monochrome Threshold.

For pictures with a dark border, it should be possible to remove the border on the Crop Picture page of the
ExpressDesign Wizard. If this is not possible, edit the picture to remove the border or change the border color.

For pictures on a dark background, use an image editor to invert the colors in the picture or change the
background color to a light color.

After editing the picture, load it again in the ExpressDesign Wizard.

EM001 ['ve selected the wrong embroidery to move or manipulate?

To deselect an embroidery, click the mouse on another embroidery. To select the desired embroidery, click on it
and an outline box will appear. If one embroidery or piece of lettering is overlapping another making it difficult to
select, click the Previous and Next Design icons on the Home tab. Alternatively, press the Tab key to select each
embroidery in turn.

EM002 "Error: Please select a valid thread."



This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM003 Some of the icons are 'grayed out'

Certain icons (for example Save and Save As on the File tab and most of the Home tab icons) are only
highlighted once an embroidery is shown on the screen.

EM004 ColorSort does not work for the multi-color monogram that | created

When creating multi-color lettering, ensure that the Jump Connection is selected. If Running Connection is
selected, you will not be able to ColorSort the lettering.

EM005 "A group is selected. To modify one item, use Restrict Groups and then
select the design you wish to modify."

This message is displayed if you click the Modify tab when a group is selected. Select the item within the group
that you wish to edit individually after using Restrict Groups, then click the Modify tab again.

EM006 \When | ColorSort an embroidery the number of color blocks produced
varies

The ColorSort process does not just put the same color blocks together. It checks for overlap between areas,
therefore depending on the overlaps, the final number of color blocks may vary, even if you are Combining a
similar number of elements.

EM007 "Please enter an integer between 3 and 200"

This message appears if the size entered in the Size Box on the Letter tab is below 3mm or above 200mm. The
Size setting refers to the height in millimeters of an uppercase 'A' in the selected font. If you wish to increase
lettering above this you could click and drag one of the corner boxes or alter the Height or Width proportions.

EM008 "Multiple items are selected. Please ensure only one item is selected."

This message is displayed if you click the Modify tab when several items are selected. Click the individual item
that you wish to modify, or use the Tab key to step through the designs until the desired one is selected, then click
the Modify tab again.

EM009 "A design must be selected to use the features of the Modify tab."

This message is displayed if you click the Modify tab when no item is selected. Select an item, then click the
Modify tab again.

EMo010 "Error. Font file is corrupt.”

This message appears when trying to select or use a lettering style if the file has corrupted. Reinstall the font.

This may also appear if a font is created in PREMIER+™ 2 Font Create and has no characters defined. Use
PREMIER+™ 2 Font Create to define at least one character in the font.



EM011 Error: "Embroidery is too large or not in the hoop"

This message appears if an embroidery you are trying to Export or Print is outside the selected hoop or larger
than will fit in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x
100mm might be placed partially outside the work area when you click Export or Print. This message would then
appear. Move the embroidery completely within the four blue corners of the work area and try again.

EM012 Error: "No embroideries available to print. Only embroideries that are
combined and inside the hoop can be printed."

This message appears if the embroidery on screen is partially outside the selected hoop. Move the embroidery
completely within the four blue corners of the work area and try again.

EM013 "This will fix your selected design as embroidery stitches. Do you wish to
continue?"

This message is displayed if you click the Modify tab when a SuperDesign, Lettering, or frame is selected. When
a design is fixed, the stitches are then created, and any further resizing may affect stitch density and length. The
stitch properties, for example the density, pattern, angle or stitch length, may not be changed after it is fixed, and
for lettering the font and text may not be changed. Only click OK if you wish that item to be fixed as stitches.

EM014 "Decorations cannot be edited using the features on the Modify tab."

This message is displayed if you click the Modify tab when decorations are selected. You cannot adjust
decorations on the Modify tab.

EM015 "Pasting into the Modify tab will combine and fix as stitches all designs
from the clipboard block."

This message is displayed if you copy designs to the clipboard block, and then attempt to paste them into the
Modify tab. Only click OK if you wish the items to be fixed as stitches.

EM016 "How do | change a design within a group?"

If a design is within a group, you cannot initially select it individually for adjusting. Use Restrict Groups on the
Home tab or context menu, and then select the desired design, lettering, SuperDesign or frame individually.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM018 The embroidery | want to work with appears too small on the screen.

Make sure the PREMIER+™ 2 Embroidery window is maximized by clicking the Maximize icon on the title bar.
Click Zoom To Fit to expand the hoop so it fills the work area. Also, choose a Hoop Size in Hoop Selection that is
suitable to the embroidery size.

EM019 | find it hard to select the part of the embroidery | wish to edit.

Many functions of PREMIER+™ 2 Embroidery can be used to help see sections of embroideries more easily.
They include the Zoom Commands and the Draw Range. The different methods of selection (Box Select,
Freehand Select, Freehand Point Select and Select All Visible) are also useful for different situations.



EM020 Error message "The program requires a color palette of High Color (16
bit) or higher."

This message appears when attempting to open PREMIER+™ 2 Embroidery if your computer is set to a display
of 256 colors or less. Reset the display as follows:

1. Right-click on the desktop and a shortcut menu appears.

2. In Windows® 7, click Screen resolution, then click Advanced settings - Properties box will appear. From
there click the Monitor tab.

3. Change Color quality to High Color (16 bit) or higher using the drop-down menu.

4. Click OK, and allow your computer to restart if required.

EM021 It seems to take a long time to redraw embroideries when | choose
different functions or switch to a new embroidery

The refresh rate of the screen is limited by the power of your computer's processor and RAM as well as the video
card and its memory. To get the best performance from your system, try using 2D view as this requires less power
than 3D view.

EM022 Some of the icons in the toolbar are 'grayed out'.

Certain icons (for example Save and Export on the Quick Access Toolbar) are only highlighted once an
embroidery is shown on the screen.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM024 | have moved the Design panel and | can't put it back in position

If the Design panel is 'floating' on top of the window, double-click the title bar and the Design panel will move back
to its original position.

If the Design panel is docked on the wrong side of the window, click and drag the title bar to the middle of the
right-hand edge of the window until the outline snaps into position on the right. Release the mouse button and the
Design panel will be dropped into its original position.

EM025 \When | try to resize a design, the resize is always proportional.

If a design is within a multiple selection or a group, resizing is always proportional. Either use Restrict Groups on
the Home tab or context menu and select the desired designs individually, or Ungroup and Combine all of the
designs to resize them together in different proportions.

EM026 | want to change the size of the lettering, but the control boxes have no
effect

For the following Lettering Shapes, there are no control boxes to change the size of the characters in the lettering:

¢ Circle Clockwise
« Circle Counter-Clockwise



« Full Circle
 Fit To Straight Line
» Fit To Wavy Line

Instead, use Size, Height and Width in Letter Properties to change the size of the characters.

EM029 | have increased the Gap setting, but the lowercase characters are still
touching each other

For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script fonts use a special
'continuous' joining method, which places lowercase characters adjacent to each other to give the appearance of
handwriting. All the fonts in the Script category use this joining method, and you may also create new fonts with
the QuickFont Wizard or the optional PREMIER+™ 2 Font Create module that use this joining method.

EM030 All the lettering appears in uppercase, even though | have typed
lowercase characters in the Letters box

You are using an uppercase font. In an uppercase font (with UC in the name), all the lowercase characters are
identical to the uppercase characters.

EM031 All the lettering appears in lowercase, even though | have typed
uppercase characters in the Letters box

You are using an lowercase font. In an lowercase font (with LC in the name), all the uppercase characters are
identical to the lowercase characters.

EM032 | have placed multiple lettering with different text in each item and | want
to change the text that appears in some of them. However, the text in the Letters
box stays the same when | select earlier pieces of lettering.

Select the desired lettering with green handles, then right-click on the lettering. The Letter Properties will appear
and you may change the text.

Once lettering has been converted to embroidery (white or blue handles), no adjustments can be made with
Letter Properties.

EM033 \Why can’t | mirror a selected design?

If a design is within a multiple selection or a group, there is no flip handle, and you cannot mirror the multiple
selection or group. Either use Restrict Groups on the Home tab or context menu and select the desired designs
individually, or Ungroup and Combine all of the designs to mirror them together.

EM034 \When | pasted a decorated design into the Modify tab | could not see the
decorations, but when | moved to the Home tab they appeared.

If you paste a design with decorations into the Modify tab, the decorations are not visible. They will reappear as
separate subdesigns when you move to one of the other tabs. Retain or delete them as desired.

EM036 | used Box Select around an area, but selected some stitches | didn't
want. Undo is grayed out so | can't click it.

To cancel a stitch block selection made using Box Select, Freehand Select, Freehand Point Select or Select All
Visible, click anywhere in the currently active embroidery, but outside the box showing the selected stitches. The



stitches will no longer be selected.

EM037 Why is the stitch order of my embroidery different in Design Player from
when | use the slider bars in the Modify tab?

Design Player uses the Export settings in PREMIER+™ 2 Configure when displaying the stitching out of an
embroidery. The slider bars in the Modify tab show the stitch order as displayed in the Color Select area of the
Design Panel. If the embroidery is ColorSorted, some color blocks may be placed together. If ColorSort is

selected in the Optimize for Sewing settings in the Export tab of PREMIER+™ 2 Configure, Design Player will
then show different results from the slider bars.

EM038 | have selected the correct hoop size, but the graphical representation
does not look the same as my real hoop
This will happen if you choose a Universal Hoop that is the same size. The Universal Hoops are shown as plain

hoops of the selected size. Use Hoop Selection to choose the desired hoop size, using a manufacturer hoop
rather than a Universal Hoop.

The hoop is only shown graphically when 3D mode is selected. Therefore, it is not shown graphically when the
Modify tab in PREMIER+™ 2 Embroidery Extra is selected.

EM039 | have a multi-part hoop selected, so my embroidery is split into more
than one section. However, when | use Send Express, only one section of the
embroidery is sent to the embroidery machine.

Only the currently selected section can be sent to an embroidery machine when some multi-part hoops are

selected.

1. Send the first section and stitch it out.
2. Then adjust the hoop for the next section, send it and stitch it out.
3. Continue until the whole design has been completely stitched out.

Note that for certain embroidery machines such as the Husqvarna Viking Designer series, and the Pfaff creative
series, multi-part embroideries are transferred in one .vp3 file.

EM040 The Design panel is not showing or is in the wrong position in
PREMIER+™ 2 Embroidery.

If the Design panel is visible but in the wrong position, first try to click and drag its title bar to move it back to its
normal position on the right.

If the Design panel is not visible, click Show Design Panel in the View tab to view the panel.
If this does not work, use Reset All Modules.

Note that Reset All Modules affects all modules in the PREMIER+™ 2 Embroidery System, so any changes to
settings in each module will be reset. The recent files list on the File menu is also cleared, but this does not affect
any files you have saved.

To use Reset All Modules:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

2. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

3. Click Reset All Modules.

4. A message will appear, indicating that all modules will be closed and reset. Click OK.

5. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

6. A message will appear, indicating that all modules have now been reset. Click OK.

The next time you start PREMIER+™ 2 Embroidery, the Design panel will be in the correct position.



EM042 | have used an odd number of repeats in the Encore function and the
center of rotation is not in the same place as the center of the circle after | right-
click.

This is because the shape of an embroidery becomes a factor when there is an odd number of repeats. For an
even number of repeats, the shape of an embroidery is cancelled out by the exact same shape on the opposite
side of the circle. For an odd number of repeats, the circle is not 'balanced' in quite the same way, so the center
point of the final embroidery may not be in the same place as the original center of the circle after you right-click.

This may also happen with an even number of repeats when the Mirror option is chosen for Position and the
embroidery is not horizontally symmetrical. If you regard each pair of mirrored embroideries as a single item, an
odd number of pairs may cause the center of rotation to move.

EM043 The Mirror option does not seem to have any effect.

If your embroidery is horizontally symmetrical before you use the Encore function, the Mirror option will have no
apparent effect. However, it will affect stitch order of each alternate copy. For example, clockwise stitching will
become counter-clockwise, and so on.

EM044 How can | tell if an embroidery is already endless?

The Notes for an embroidery will have the words Endless added after any other Notes text. If the Notes have
been edited so that this is no longer the case, use the slider bars on the Edit tab to see if there are marker
stitches at the beginning and end of the embroidery.

EM045 | ColorSorted my design. Why are there so many colors in the Color
Select area for it?

If you use ColorSort on a multiple selection or group, the number of colors seen in the Color Select area may be
more than if the same embroideries were combined. This is because ColorSort looks at the embroideries within
the selection or group separately. To keep embroidery elements editable in your project and minimize the number
of colors when stitching out, use Export with ColorSort to create a version for stitching.

Use Design Player or Print Preview to see how many colors the exported embroidery will have, according to the
current options.

EM046 | forgot to set a Gap, but it does not appear to have worked when | tried
to make the Endless Embroidery again.

This can happen if you use the Repeat Embroidery option and you do not use Undo before trying again. This is
because you have already created a repeated sequence with no gaps that then becomes a single embroidery. If
you then use the Endless Embroidery function again to try to add a Gap, the whole repeated sequence is treated
as a single embroidery. This should be apparent if you look at the Notes, because the word 'Endless’ will occur
twice at the end of the Notes. Always click Undo to go back to the single copy of the embroidery before trying
Endless Embroidery again with different settings.

EM048 When | hover the mouse pointer over a color in the color worksheet, part
of the embroidery changes to an unusual color.

This is called "Highlight Selected Color". It allows you to see where each color is used in an embroidery. For
example, if you have several color blocks using the same thread color and you wish to change the color of a
specific section, hover over each color in the worksheet in turn until the section you require is highlighted.

EM049 "Problem with scanner or camera software."



This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close PREMIER+™ 2 Embroidery, follow the manufacturer's instructions for the WIA-compliant device,
then reopen PREMIER+™ 2 Embroidery and try again.

EM050 "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the WIA-compliant device. Close PREMIER+™ 2 Embroidery and the other graphics
program, then reopen PREMIER+™ 2 Embroidery and try again.

EM051 "Your scanner or camera is no longer available for use. Close this
program, plug in and switch on your scanner or camera, and run this program
again."

This message will appear if the connection to your scanner or digital camera has a problem. Close PREMIER+™

2 Embroidery, check the connections to your scanner or digital camera, then reopen PREMIER+™ 2 and try
again.

EM052 "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close PREMIER+™ 2 Embroidery Extra, check the
connections to your scanner or digital camera, then reopen PREMIER+™ 2 Embroidery Extra and try again.

EM054 Can | edit my monogram after placing it on the work area?

When you have created a monogram and placed it in the work area, right-click it and select Properties to reopen
the ExpressMonogram Wizard with the monogram loaded. The pale green handles indicate that the monogram
has not been fixed as an embroidery, and can still be adjusted in the ExpressMonogram Wizard.

EM055 The preview picture is blank or almost blank on the Express Trace
Options or Express Border Options page.

This may happen if the outlines in the picture are only one pixel wide after the Monochrome Threshold page.

For Express Trace, return to the Outline Finder and Expander page, select Find Outlines and ensure Expand is
setto 1.

For Express Border, first click Picture Options and set the Area Sensitivity to High. If this does not have the
desired effect, return to the Monochrome Threshold page and adjust the slider so that more of the picture within
the desired areas turns black. If this also selects unwanted parts of the picture, you may need to remove the
unwanted areas in a picture editor.

PREMIER+™ 2 Create and PREMIER+™ 2 PhotoStitch have picture editing functions that may be used to
remove unwanted areas.

EM056 How do | save my monogram so | can adjust it later?

If your monogram in the work area has pale green handles (indicating that it has not been fixed as an
embroidery), you can save it individually, or as part of a selection or group in a .vp4 file.

EM057 \When | use the Hoop option for Encore, everything seems to get stuck.

As with Circle and Line, you must click Apply to finish using Encore and create the repeated embroidery. Until you
click Apply, Encore is simply previewing the chosen Encore Hoop settings and you may click the Encore buttons



to change settings. Notice also that there is no selection box shown around any embroidery when Encore is
active.

If you click one of the other control panel tabs, Encore will be cancelled, the preview will be removed from the
screen and the original embroidery will be selected.

EM058 | have adjusted my lettering on the work area, but when | change the
Letter Properties, the lettering changes shape a little.

The control boxes on blocks of lettering allow subtle adjustments directly to the shape of the lettering. However,
the Letter Properties only allows the proportions of Height and Width to be adjusted. When the Letter Properties
are changed, the previous adjustments may be partially lost when the Height and Width values are applied.
Therefore, it is recommended to make all desired adjustments in Letter Properties before making final
adjustments directly with the control boxes.

EM059 Error "No letters in font file."; when generating special characters

This message can occur if you have are trying to generate some special characters from fonts you have made in
the QuickFont Wizard and the Check Spelling option is selected in Preferences.

Open Preferences.
1. Uncheck the Check Spelling checkbox.
2. Click OK.
3. Close down PREMIER+™ 2 Embroidery/Embroidery Extra.
4. Re-open PREMIER+™ 2 Embroidery/Embroidery Extra.
5. Generate the characters again.

EM060 How can | resize my monogram on the work area?

When a monogram is resized on the work area, it is fixed as a group of embroideries and you will not be able to
edit the text. To change the size of a monogram without fixing it, right-click and select Properties in the Context

menu to open it in the ExpressMonogram Wizard. You can then resize the letters within the monogram, and the
border around it.

EM062 | have adjusted my lettering on the work area, but when | change the
Letter Properties, the lettering changes shape a little.

The control boxes on blocks of lettering allow subtle adjustments directly to the shape of the lettering. However,
the Letter Properties only allows the proportions of Height and Width to be adjusted. When the Letter Properties
are changed, the previous adjustments may be partially lost when the Height and Width values are applied.

Therefore, it is recommended to make all desired adjustments in Letter Properties before making final
adjustments directly with the control boxes.

EM063 In Letter Options | tried to edit the Stitch Type for my lettering, but the
drop-down menu was grayed out.

If a font does not use an editable stitch type, the Stitch Type will not be available in Letter Options.

EM064 The alignment stitches for the second part of a design seem to have
disappeared

Some multipart embroideries are created with alignment stitches that overlap exactly. When viewing these
designs in PREMIER+™ 2 Embroidery, deselect Remove Overlap in PREMIER+™ 2 Configure, Export, before
sending them to the embroidery machine.



EM065 \When | resized a decoration design, some areas showed an increase in
the numbers of beads, while others became more spaced out.

When a decoration line or shape is enlarged, the number of decorations increases; and when it is made smaller
the number decreases. Where decorations are placed individually, the number of decorations does not change
when the decoration subdesign is made larger or smaller.

EM067 How do | find the MyFonts folder on my computer?

The MyFonts folder for the Premier+ Embroidery System, can be found here:
Windows® 7 / Windows® 8 /| Windows® 10 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\MyFonts
If you do not see the ProgramData folder; then you may have to take the following steps to stop them being

hidden by your operating system:

. Click on your Start menu.
. Click on Control Panel.

. Click on the Folder Options link.

AR ON -

. Type folder option into the Search textbox

. The Folder Options dialog box will appear — set it to Show hidden files, folders and drives files and

uncheck the two Hide options indicated in the screenshot — click Yes to the warning message.

6. Click OK.

~

. Once you have followed all the instructions for accessing the MyFonts folder, you can reverse these

instructions to put the Folder Options to what they were.
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EM068 \What is the largest design that can
be made in PREMIER+™ 2 Embroidery
Extra?

The largest design that can be created is 4000mm x 4000mm
(4 meters by 4 meters)

EM069 "Please select letters for the
monogram"

This message appears if you try to create a monogram with no
letters selected. Select some letters.

EM070 "One of your letters is not valid"

This message appears if you try to create a monogram using a
character that is outside the available font range (ASCII 33-
255). Use a valid character.

EM072 "Error. This scanned image type is

This message will appear if the scanner has created an image file that is not supported by PREMIER+™ 2
Embroidery. Convert the image to a supported image file format.

EMO073

"Error. Cannot open Font File."

This message appears if the font or SuperDesign set that you have selected is not available. The most likely
reason is that it is already open in the optional PREMIER+™ 2 Font Create module. Close PREMIER+™ 2 Font



Create, then try again.

This could also happen if you opened the PREMIER+™ 2 Embroidery program, then accidentally moved or
deleted the font from the relevant category folder in ProgramData\VSMSoftware\Premier+2\Fonts, or the
SuperDesign file from ProgramData\VSMSoftware\Premier+2\SuperDesigns. Close PREMIER+™ 2 Embroidery,
make sure the file is in the folder, then try again.

EM074 "Error. No SuperDesigns, Frames or or Flourish files found."

This message appears if the SuperDesigns or Frames folder is empty or has been accidentally moved, deleted or
renamed. Close PREMIER+™ 2 Embroidery, make sure the folder
ProgramData\VSMSoftware\Premier+2\SuperDesigns, or \Frames, is in the correct location and contains the
SuperDesign or frames files, then try again.

If you are unable to restore or replace the SuperDesigns or Frames folder, repair the installation. Put your
PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the PREMIER+™ 2
Components installation. When the choice appears, select the "Modify or remove" option and click Next. In the
next screen, select Repair and click Next. Continue with the installation and follow the on-screen instructions.
When the installation is complete, the SuperDesigns or Frames will be restored.

Check Smart Update in PREMIER+™ 2 Configure after repairing the installation.

EM075 "Error. No letters in font file."

This message may appear if the font is corrupt, or if the character selected is not in that font. Reinstall the font, or
use PREMIER+™ 2 Font Create to add the character to the font.

EM076 "Error - Shapes database is corrupt or missing."

This message appears if the database of Frames and Borders, or the database of shapes used for Encore
shapes, shape fill, and creating border and appliqué shapes, has been corrupted or accidentally moved or
deleted.

This error does not prevent PREMIER+™ 2 Embroidery from starting. However, you will not be able to use the
relevant functions until this is resolved. To correct this, start the installation for your PREMIER+™ 2 Embroidery
System software, then choose the Repair option.

If the problem persists, delete the file named 'BorderShapes.bdr' from
ProgramData\VSMSoftware\Premier+2\System, and then use the Repair option again.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error.

EM077 The color worksheet appears blank.

If no design is selected, or more than one design is selected, the worksheet will be blank. To view and change the
threads in an embroidery, select the single embroidery, then view the threads in the color worksheet.

EM078 Certain features are always grayed out (unavailable).

Certain functions are only available in PREMIER+™ 2 Embroidery Extra, for example the ExpressDesign Wizard,
the PhotoStitch Wizard, the QuiltBlock Wizard, Split Project Wizard and the Background Wizard. In PREMIER+™
2 Embroidery these functions will be grayed out (unavailable).

Other functions are available only if PREMIER+™ 2 ULTRA is owned, such as the Family Tree Wizard and many
PhotoStitch Wizard options.

EM079 My picture already has outlines, but some outlines are not traced properly
when | create an Express Trace embroidery.



This can happen if the outlines in your original picture are only one pixel wide. For example, there may be gaps or
missing sections of the outline. If this happens, select Find Outlines on the Outline Finder and Expander page and
ensure Expand is set to 1. This will thicken all the outlines so that they are traced correctly.

EM080 My picture only makes a rectangular border when | create an
ExpressBorder.

This can happen with a picture that has a border or background that is black or very dark, especially if the
background or border cannot be removed with Monochrome Threshold.

For pictures with a dark border, it should be possible to remove the border on the Crop Picture page of the
ExpressDesign Wizard. If this is not possible, edit the picture to remove the border or change the border color.

For pictures on a dark background, use an image editor to invert the colors in the picture or change the
background color to a light color.

After editing the picture, load it again in the ExpressDesign Wizard.

EM081 | would like to remove the lines created from the white background of my
picture by Linear PhotoStitch embroidery.

After creating and saving an embroidery, use the Edit tab in PREMIER+™ 2 Embroidery Extra, or open the file in
PREMIER+™ 2 Modify, and use the following instructions.

1. Use the Freehand Point Select feature to mark the stitches in the background.
2. Click the Delete button.
3. Save the adjusted embroidery.

EM082 Could not load picture file.

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a USB memory stick, then closed and the memory stick removed. It could also appear if the file you
are attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a
proper picture file.

EM083 | have used a motif as an envelope border and the results are
unexpected.

If the selected motif width is larger than the size of the monogram or name, then only one motif may be created.
Adjusting lettering or motif size or spacing may allow multiple motifs to be included in the border. If the selected
motif shape is irregular it may overlap the monogram. Adjusting lettering or motif size or spacing may produce the
desired results.

EM084 The selected Frame or Flourish cannot be seen completely.

Frames and Flourishes with running stitch that is vertical or horizontal are not always completely visible at zoom
to fit. This varies depending on the font, size of lettering and envelope. Use the Zoom In feature, if desired, to
verify that the stitching exists.

EM085 When | use I’ or 'W’ in a monogram, the result looks unbalanced.

The Monogram font category fonts Condensed Block and Square Block include two versions of the characters 'l
and 'W'. If you enter an upper case letter, the displayed version will be even width (square). If you use a lower
case I’ (or I, I, I or 1) the letter will be narrower. If you use a lower case "W’ the letter will be wider.

EM087 | want to change the design that has been used in the corners in Encore.



In Encore Shape and Encore Hoop, when two embroideries are selected, the embroidery that is first in the stitch-
out order will be placed in the corners. If you want to use the other embroidery in the corners, use Layout Order to
change the order.

EmM088 Not all of my designs have been used in the Encore function.

A maximum of two designs can be used with Encore Shape and Encore Hoop. If more than two designs are
selected, only the first two that were loaded will be used in the Encore. Either use Encore Circle or Line, or group
some of the embroideries before using Encore.

EM090 The Endless function does not work.

The Endless function is not available in any of the following situations:

» There is no embroidery loaded, so there is nothing that can be made endless: load an embroidery
» The embroidery is too big for or is outside the current hoop: adjust the embroidery as needed or choose a
larger hoop

EM091 | don’t remember which font | used when making an embroidery.

If lettering, a SuperDesign or frame has green handles it has not yet been fixed as stitches.

Simply right-click and choose Properties or the desired stitch type from the context menu to see the font and
stitch properties used to create it. Otherwise, view the settings; information on the font, SuperDesign, Motif or
Frame used in an embroidery made in PREMIER+™ 2 Embroidery is stored in the Settings. Open the embroidery
and click the Settings tab in the Home tab to view the settings. Alternatively, print a worksheet for the embroidery.

EM092 The letters | am designing in PREMIER+™ 2 Font Create are not
appearing in PREMIER+™ 2 Embroidery.
PREMIER+™ 2 Embroidery and PREMIER+™ 2 Font Create cannot have the same font open at the same time.

Therefore, you must close the font in PREMIER+™ 2 Font Create to make it fully available to PREMIER+™ 2
Embroidery.

EM093 | want to change the size of the lettering, but the control boxes have no
effect.

For the following Line Types, there are no control boxes to change the size of the characters in the lettering:

« Circle Clockwise
Circle Clockwise
Full Circle

Fit To Straight Line
Fit To Wavy Line

Instead, use Size, Height and Width in Letter Properties to change the size of the characters.

EM094 | want to change the appearance of the font stitching, but the Stitch Type
drop-down is not available.

If the Stitch Type area is grayed out (unavailable), this means that the area was designed with properties cannot
be edited. For example, this occurs with Foam fonts that have special settings to ensure the embroidery foam is
cut, and it also occurs with a few very complex fonts that have many different fill patterns in different letters, or
multigradient fills, such as Acorn 6C UC 35-60mm in the Floral category.



EM095 \When | try to change the stitch properties the Stitch Type drop-down is
grayed out (unavailable).

If the Stitch Type area is grayed out (unavailable), this means that the area was designed with properties cannot
be edited. For example, this occurs with Foam fonts that have special settings to ensure the embroidery foam is
cut, and it also occurs with a few very complex fonts that have many different fill patterns in different letters, or
multigradient fills, such as Acorn 6C UC 35-60mm in the Floral category.

EM096 \When | use a Script font with the Full Circle line type, the characters are
not arranged correctly.

Script fonts use a special connection method that allows adjacent lower case letters to be connected to each
other, regardless of the Gap setting. This is not compatible with the way the characters are arranged by the Full
Circle line type.

Circle Clockwise and Circle Counter-Clockwise are compatible with Script fonts.

EM100 | have adjusted my lettering on the work area, but when | change the
Letter Properties, the lettering changes shape a little.

The control boxes on blocks of lettering allow subtle adjustments directly to the shape of the lettering. However,
the Letter Properties only allows the proportions of Height and Width to be adjusted. When the Letter Properties
are changed, the previous adjustments may be partially lost when the Height and Width values are applied.
Therefore, it is recommended to make all desired adjustments in Letter Properties before making final
adjustments directly with the control boxes.

EM101 In Letter Options | tried to edit the Stitch Type for my lettering, but the
drop-down menu was grayed out.

If a font does not use an editable stitch type, the Stitch Type will not be available in Letter Options.

EM102 In SuperDesign Options | tried to edit the stitch properties for my
SuperDesign, but the drop-down list was grayed out.

If a SuperDesign does not include an editable stitch type, the Stitch Type drop-down list will not be available in the
SuperDesign Options dialog box.

EM103 In Letter Properties | tried to edit the Stitch Type for my lettering, but there
was no drop-down menu.

Stitch types are not available in the Letter Properties dialog box. Right-click the lettering, and select the stitch type
from the right-click menu.

EM104 When | moved a design, its appliqué did not move with it

Appliqué is associated with the selected Color Change or Stop. If you add appliqué to a Color Change or Stop in
a different design, the appliqué will be associated with the selected design, not the desired one. Make sure that
you select a Color Change or Stop in the desired design before adding appliqué.

EM105 When | added appliqué to a design, the fabric was placed on top of the
stitching.



Appliqué is associated with the selected design. If you add appliqué to a design that is not selected, the stitching
will be treated as background stitching, and the appliqué will be placed on top of it. Make sure that you select the
desired design before you add appliqué to it.

EM108 When | print my embroideries the grid is not shown at the correct size.

If you select Hoop Zoom to Fit in the Print page, the grid will be proportional to the scaling used to fit the hoop to
the printed page. If you select 'Garment/Quilt Block Zoom to Fit’ or 'Garment/Quilt Block Real Size’ in the Print
page, the grid will extend across the whole of the selected background, not just the hoop area. The grid will be
proportional to the scaling used to fit the garment and hoop to the printed page.

EM109 | made a change to my design in the ExpressDesign Wizard and now |
can'’t click Finish to load the design in the work area

If you make a change to the options on the Fabric And Stitch Type Options page in the ExpressDesign Wizard,
you must click Refresh Preview to view your changes before you can click Finish. Refresh the preview, then
Finish.

EM110 | would like to get rid of the stray stitches in the background of my
PhotoStitch embroidery
It is best to clean the background of a picture so that there are no flecks, as they can cause stray stitches. If some

remain in a saved PhotoStitch embroidery, remove them in the Modify tab or open the file in PREMIER+™ 2
Modify and use the following instructions.

1. Use one of the Select features to select the stray stitches.
2. Click Delete Stitches.
3. Save the adjusted embroidery.

EM111 In Font Manager one of the fonts in My Fonts shows a Minimum and
Maximum size of 0.0 mm.

In the Font Manager dialog box a font that was created in QuickFont Wizard in PREMIER+™ Embroidery or in
PREMIER+™ Font Create, and copied to your My Fonts folder, may show a minimum and maximum size of 0.0
mm. This does not affect the use of the font.

EM112 Send to Machine via mySewnet™ and PREMIER+™ 2 version 12.4 for
Windows®

The Send to Machine via mySewnet™ feature for sending designs to the HUSQVARNA VIKING Designer EPIC™
and the PFAFF creative icon™ is not currently working in PREMIER+™ 2 version 12.4 for Windows®. This issue
does not affect PREMIER+™ 2 version 12.4 for Mac®.

As a temporary workaround, you can use Send to mySewnet™ and then browse to the file on your machine.
A fix for this issue is being worked on.

EP001 No design thumbnails are shown, just an icon for the format type.

There is an option in Windows Explorer to turn off thumbnails, you may have this option turned on.

1. Open Windows Explorer.

2. Click on the Options box to open the Folder Options dialog.

3. Click on the View tab.

4. Uncheck the checkmark against the "Always show icons, never thumbnails™ option.
5. Click OK.
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EP002 My thumbnails of designs look strange in the Windows Explorer.

It could be that you have had a previous software on your computer which had shown thumbnails of stitch files.
The cache of thumbnails needs to be cleared from Windows Explorer, so that it can start using the thumbnails

shown by the Windows Explorer Plug-in.
An example of the issue can be seen below, with the incorrect thumbnail image from a third party icon software
on the left; and the correct preview on the right:
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Another example of strange thumbnail image display, is if one of the thumbnails shows with a black background. It
will also be a smaller version of the design in the center of the thumbnail.

Cat Head.vp3 Caton its Cat Sitting.vp3
Back.vp3

Clear the Thumbnail Cache to fix both types of thumbnail display issues:
Windows 10/ Windows 8

1. Open Windows Explorer — right click the Windows Explorer icon on the Task bar and select File
Explorer.

2. Windows Explorer will open to the Quick Access/Libraries folder of your computer. In the left hand pane
of the window, click on the This PC/Computer heading.

3. Right click on the Local Disk (C:) entry, then click Properties. The Local Disk (C:) Properties dialog box

will appear.
4. On the General tab, click the Disk Cleanup button. It may take a few moments while the utility analyses
the drive.
5. Uncheck everything in the list, and then place a checkmark against the Thumbnails entry at the bottom.
6. Click OK and a confirmation message will appear. Click the Delete Files button.
7. Repeat steps #3 to #6 for any other Local Disk entries that you may have in Windows Explorer.
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Windows 7

1. Click on the Start menu.

2. Click on the Computer option. Windows Explorer will open.

3. Right click on the Local Disk (C:) entry, then click Properties. The Local Disk (C:) Properties dialog box
will appear.

4. On the General tab, click the Disk Cleanup button. It may take a few moments while the utility analyses
the drive.

5. Uncheck everything in the list, and then place a checkmark against the Thumbnails entry at the bottom.

6. Click OK

EP003 When | search for designs in Windows Explorer no designs appears.



This could be because you have the Windows Search option turned off.
To turn it on:
Windows 8

1. Go to your Start screen.

2. Type windows features

3. Click on the Turn Windows Features On or Off option.
4. Scroll down to the Windows Search option.

5. Place a checkmark in the checkbox if it is empty.

6. Click OK.

Windows 7

1. Click on the Start menu

2. Type windows features

3. Click on the Turn Windows Features On or Off option.
4. Scroll down to the Windows Search option.

5. Place a checkmark in the checkbox if it is empty.

6. Click OK.

It could be that the Windows Indexing has been turned off; turn it back on and try again.
Windows 8

. Go to your Start screen.

. Type services

. Click on the Services option that appears to open the Services box.

. Scroll down to the Windows Search checkbox.

. Right click on it.

. Select Properties

. On the General tab, ensure that you have the Automatic (Delay Start) selected.
. Click OK.

. Restart your computer.

10. Now try searching for a designs properties again.

Windows 7

. Click on the Start menu.

. Type services

. Click on the Services option that appears to open the Services box.

. Scroll down to the Windows Search checkbox.

. Right click on it.

. Select Properties

. On the General tab, ensure that you have the Automatic (Delay Start) selected.
. Click OK.

. Restart your computer.

. Now try searching for a designs properties again.
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If you have your thumbnail view in Windows® Explorer set to Small icons, List or Details then you will not see

the preview - you will only see the Premier+™ logo.
Change the View to one of the other available options to see the thumbnail images of your stitch files
Changing the View:

1. Open Windows® Explorer.
2. Browse to a folder that contains stitch files.
3. Right click on an empty area of main part of the Windows® Explorer screen.



4. Move your mouse over the View option.
5. Click on Medium icons - or whichever other option you prefer to view your thumbnail images in.

View J Extra large icons
[ I [

Sort by * Large icons

Group by r B Medium icons I:}

Refresh Small icons

Custormize this folder... List

Details

st Tiles

Paste shortcut Forient

Undo Move Ctrl+Z

Share with 3

Mew 3

Properties

EQ001 | can't select a font that is on my computer.

The QuickFont Wizard is designed to work with Windows TrueType® and OpenType ® fonts. The QuickFont
Wizard does not support Postscript Type 1 fonts. To check Font Properties:

1. Click Start, Control Panel, then select Fonts.

2. Click the desired font to select it.

3. Right-click and select Properties from the menu that appears.

4. Check the Type of file section. If it is PostScript Metrics or Type 1 Font File it will not work with the
QuickFont Wizard.

EQ002 "Error. Could not set up font data."

This message may appear at the end of font creation with the QuickFont wizard if one or more characters is not
properly defined in a font. That is, there is no data in the TrueType or OpenType font about the characters, so they
have not been created in the embroidery font. This may happen with specialist or symbol fonts, which are not
designed for general text usage. If desired, use PREMIER+™ 2 Font Create to create any missing characters.

EQ003 "Error. Font is too thin to be filled."

This message may appear when trying to preview or create a font with the QuickFont Wizard. When some parts
of characters have very narrow sections, they may not be large enough to have fill areas created when the Stitch
Type is set to Fill or Fill + Satin Border. If the font is created, it may have characters or parts of some characters
missing. It is recommended to choose a different Stitch Type. Alternatively, create the font then use PREMIER+™
2 Font Create to create the missing parts and/or characters.

EQ004 \Why do | receive the "Error. Font character too complicated" message in
QuickFont Wizard?

This can happen if you have selected a very small (or complex) TrueType Font that is installed on your computer.

If a particular character is extremely small; then some of the narrower sections of a character will not be large
enough to contain a Satin/Fill area. This may result in that character not being generated.

For example when trying to generate the Garamond font; by default the 'e' character is too small to generate -
resulting in the following message



CuickFont Wizard

¥

i '- ' Font generation stopped at character 'd' (Asdi code 100)
® . Anerror occurred while processing the following characters:

& (Asci code 101) - Error. Font character is too complicated.

A way around this is to increase DPI settings on your computer (the size that your Operating System displays
your fonts at):

The image below gives an approximation of moving from normal (left) to Large (right)

e ©

Windows 7

1. Right click on an empty area of your Desktop.

2. Click on the Screen resolutionoption. The Screen resolution appears
3. Click on the Make text and other items larger or smaller option.

4. Choose the Medium (or Larger) option.

5. Click Apply. Restart your computer if prompted.

FT011 "The selected dimensions will produce a large PhotoStitch and stitch
creation may take some time. Removing background areas will reduce the time
required."

This message will appear if you specify a PhotoStitch larger than 26,000mm square. Click OK to continue
creating the PhotoStitch. To reduce the stitch creation time, remove the picture background, particularly any very
detailed areas. Stitch creation time is shorter for Linear PhotoStitch.

FT016 Error "The color xx has been found in your database, but the thread color
is not exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

GA001 | can't drag and drop embroideries from the Open dialog box

To drag and drop embroideries onto the Work Area, open Windows® Explorer. Then follow the instructions under
Drag and Drop.



GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA008 "Embroidery XY coordinates incorrect"

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA011 Error "Not enough memory to perform operation.”

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.



GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
o System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA016 | wish to change the background color for the work area

Use PREMIER+™ 2 Configure to alter the background color for the work area. PREMIER+™ 2 Configure may
also be used to change the texture for modules that use texture.

GA018 | can't see some of the floating toolbars or icons

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules
1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.



2. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

3. Click Reset All Modules.

4. A message will appear, indicating that all modules will be closed and reset. Click OK.

5. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

6. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.

If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA022 When | close PREMIER+™ 2 Embroidery all my other modules also
close

PREMIER+™ 2 Embroidery is the central module of the PREMIER+™ 2 Embroidery System. When
PREMIER+™ 2 Embroidery closes, all other open modules are closed at the same time.

If you have created a new file or made changes in another module, you will be prompted to save the file before
the module closes.

GA024 | have a very large embroidery in the clipboard block. How do | remove
it?

Click on the Clipboard Block to clear the current contents.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA032 "Please choose a valid motif pattern.”

This message appears if you try to select a motif from My Motifs, and all the motifs have been deleted from My
Motifs. Use PREMIER+™ 2 Create to add at least one motif to My Motifs.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.



The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA037 How do | find information on an error message?

To search within the FAQs for information on an error message, copy the text, or number, of the error message
into the search field, checking that you have used the correct spelling.

Note the following:

» Sometimes a short query works better (use the one or two most distinctive words).
» Try using the error text and the number in separate searches.

GA039 How do | search for information in the FAQs?

The best way to search for information in the FAQs is to use a short query, checking that you have used the
correct spelling.

Note the following:

» A query using one or two distinctive words often works best.
» Two separate searches may work better than one for a complex issue.

For example, instead of "How do | send a design to my embroidery machine?" use "send design".

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.



GA049 \When | double click on my stitch files, they now open in another software.
How can | reset the file associations?

It may be that you installed another software which is now associated with your stitch files.
To reset the association back to the PREMIER+™ 2 Embroidery System do the following steps:

. Close down all programs.

. Open PREMIER+™ 2 Configure.

. Click the Reset File Association button. A Reset File Association box will appear.
. Click on the PREMIER+™ 2 Embroidery button in the Reset File Association box.
. The Set Program Association page will appear.

. Click on the Select All checkbox. All stitch formats will be selected in the list.

. Click Save.

All the selected stitch formats will have been set back to open in PREMIER+™ 2 Embroidery.
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GA056 The From Scanner or Camera option is not available, even though my
scanner/camera is plugged in.

The From Scanner or Camera option may not be available, even though you have installed and connected a
scanner/camera, if it does not support Windows Image Acquisition (WIA). If your scanner/camera supports a
different image acquisition system, e.g. TWAIN, create a .png or .jpg file of the image in My Pictures, and load it
from there.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE003 "Motif database is missing or corrupt. Cannot change motif."

This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb' from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

GE025 In Windows® 10, when | click Reset File Association in PREMIER+™ 2
Configure, a Windows® message appears.

In Windows® 10, you will need to manually reset the file association:
1. Click on the Start menu in the bottom left corner of your screen.



. Click on Settings. The Settings window will appear.

. Click on the System button.

. Click on the Default apps entry on the left hand pane.

. Scroll to the bottom of the right hand pane.

. Click on the Set defaults by app link. The Set Default Program window will appear.

. Click on the PREMIER+™ 2 Embroidery entry from the left hand pane.

. Click on the Choose defaults for this program link on the right hand pane.

. Place a checkmark in the Select All checkbox - this will place a checkmark in all checkboxes if they were
not already checked.

. Click Save. This will associate all the available stitch formats from step #9 with PREMIER+™ 2
Embroidery.
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Click the Windows 10 Reset File Association link to see a video of the above process.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

You can use Export to save an embroidery to a floppy disk for a Husqgvarna Viking Designer | sewing machine.

In the Export dialog, select Husqvarna Viking Designer | (.shv), then select the Floppy Disk tab below. If desired,
use Format Drive to format the disk before saving.

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some



folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...'.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

» Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
» Add info@embroiderynewsletter.net to your email Contacts or Address Book.

» Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
» Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".




4. Click Next to unsubscribe.

GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16 Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.



Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error: ParentFrame download failed. Error #Permission denied.
This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN020 Error: "The program can't start because api-ms-win-crt-runtime-11-1-0.dll is
missing from your computer. Try reinstalling the program to fix this problem."

This error message appears when some Windows update files are absent from a computer with Windows 7 or
Windows 8. Use Windows Update to ensure that all updates have been installed.

This may take quite a long time, and involve restarting your computer several times.

To check which updates have been installed, search for "Windows Update" on your computer, and in the pane on
the left of Windows Update, select View Update History. Check that updates have been installed recently, and that
all updates are marked as Successful in the Status column. Use the troubleshooting instructions to install any
missing updates.

Error HO0O07 may be seen after you have updated. For more information, see INO21.

IN021 Error: "HOO007 Sentinel key not found"

This error message may appear during activation. Use the HO007 fixer utility to correct the problem.

1. Download the utility Error HO007 fix.

2. Double click on the Premier+2_HO0007_Fixer.exe file
3. Follow the on-screen instructions

4. Open the PREMIER+™ 2 Embroidery software.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

Pcoo1 Invalid credit card number (pre-validation)

You have entered an invalid credit card number. Correct the number and try again.

PCc002 Error: You must accept the Terms and Conditions before continuing

You have not selected (checked) the box accepting the Terms and Conditions. Check this box and try again.
Now you will be able to continue in the Embroidery Purchase Center.

PC003 The expiration date has passed



The expiration date that you selected from the drop-down list is in the past. Either you selected the wrong date, or
your credit card is out of date.

PCcoo4 One or more required fields are missing

This will appear in the Payment Details page if at least one of the required fields is empty. This could happen if
your billing address and delivery address were not the same, and you had clicked Next before adding the
changed details.

PC005 The payment was accepted but an unexpected error prevented the
process completing. Please contact embroidery software support for more
information.

Something is wrong with your registration, so the Product Activation Code could not be added to it. Contact
embroidery software support for a diagnosis of the problem.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso011 How do | view the PREMIER+™ 2 online documentation on my Apple
IOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading



1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.

** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Family Tree

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 /| Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.

O ~NO O~

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.



Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM030 All the lettering appears in uppercase, even though | have typed
lowercase characters in the Letters box

You are using an uppercase font. In an uppercase font (with UC in the name), all the lowercase characters are
identical to the uppercase characters.

EM031 All the lettering appears in lowercase, even though | have typed
uppercase characters in the Letters box



You are using an lowercase font. In an lowercase font (with LC in the name), all the uppercase characters are
identical to the lowercase characters.

EM073 "Error. Cannot open Font File."

This message appears if the font or SuperDesign set that you have selected is not available. The most likely
reason is that it is already open in the optional PREMIER+™ 2 Font Create module. Close PREMIER+™ 2 Font
Create, then try again.

This could also happen if you opened the PREMIER+™ 2 Embroidery program, then accidentally moved or
deleted the font from the relevant category folder in ProgramData\VSMSoftware\Premier+2\Fonts, or the
SuperDesign file from ProgramData\VSMSoftware\Premier+2\SuperDesigns. Close PREMIER+™ 2 Embroidery,
make sure the file is in the folder, then try again.

FT001 Error message "The program requires a color palette of High Color (16
bit) or higher."

This message appears when attempting to open Premier+™ Family Tree if your computer is set to a display of
256 colors or less. Reset the display as follows:

1. Right-click on the desktop and a shortcut menu appears.

2. In Windows® 7, click Screen resolution, then click Advanced settings - Properties box will appear. From
there click the Monitor tab.

3. Change the Color quality to High Color (16 bit) or higher using the drop-down menu.

4. Click OK, and allow your computer to restart if required.

FT002 Error "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types.

FT003 "Error. No character set is defined. Cannot open .ged file."

The family tree (.ged) file cannot be read. Where possible, export the file again from the original program, using
the ASCII character set.

Note: This error message may be reported when importing GEDCOM files from other family history programs.

FT004 "Error. No family data found. Cannot open .ged file."

The family tree (.ged) file cannot be read. Export the file again from the original program. You may need to adjust
your export settings.

FT006 "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close PREMIER+™ 2 Family Tree, follow the manufacturer's instructions for the WIA-compliant device,
then reopen PREMIER+™ 2 Family Tree and try again.

FT007 "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the WIA-compliant device. Close PREMIER+™ 2 Family Tree and the other graphics
program, then reopen PREMIER+™ 2 Family Tree and try again.



FT008 Error message "Your scanner or camera is no longer available for use.
Close this program, plug in and switch on your scanner or camera, and run this
program again."

This message will appear if the connection to your scanner or digital camera has a problem. Close PREMIER+™

2 Family Tree, check the connections to your scanner or digital camera, then reopen PREMIER+™ 2 Family Tree
and try again.

FT009 Error message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close PREMIER+™ 2 Family Tree, check the
connections to your scanner or digital camera, then reopen PREMIER+™ 2 Family Tree and try again.

FT010 Error message "Could not load picture file."

This message could appear if the desired picture is not where the program expects it to be, for example if it was
loaded into the program from a USB memory stick, then closed and the USB stick removed. It could also appear if
the file you are attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not
be a proper image file.

FT011 "The selected dimensions will produce a large PhotoStitch and stitch
creation may take some time. Removing background areas will reduce the time
required.”

This message will appear if you specify a PhotoStitch larger than 26,000mm square. Click OK to continue
creating the PhotoStitch. To reduce the stitch creation time, remove the picture background, particularly any very
detailed areas. Stitch creation time is shorter for Linear PhotoStitch.

FT014 Error "Failed to create the embroidery chart - this family tree is too
complicated, and cannot be created. Please reduce the Ancestor/Descendant
levels."

This message may appear in the Customize Chart page of the Chart Wizard where a family tree includes
complicated features, for example, marriage between relatives. Reduce the number of generation levels in the
chart, and try again.

Note: This will only happen with imported GEDCOM files, as this type of family structure cannot be created within
PREMIER+™ 2 Family Tree. Where relatives have married, recreate the individual.

FT015 Error "Failed to create the embroidery chart - the generated design will be
larger than 4.5m in width or height. Please reduce the Ancestor/Descendant
levels and try again."

This message may appear when a family tree chart would be larger than 4.5m (too big to split). Reduce the
number of generation levels in the chart, and try again.

FT016 Error "The color xx has been found in your database, but the thread color
is not exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have



additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

FT022 Some of the icons in the Toolbar are 'grayed out'

Certain icons (for example Move Child Up on the Family tab) are only highlighted once it is possible to perform
the action concerned.

FT023 Certain functions don't seem to work all the time

Some functions, such as the Zoom buttons, are only available when the Tree View tab is selected. To use these
functions, click the Tree View tab on the control panel.

Similarly, Edit Selected, Back, Forward, Move Child Up and Move Child Down are only available when the Family
View tab is selected.

FT024 When | move a child up or down the list, the father is selected afterwards

The father becomes the selected individual after you have used Move Child Up, or Move Child Down, because a
change has been written to the GEDCOM file. To move the child further up or down the list, select it, and move it
again.

FT026 | have already made a family tree, but PREMIER+™ 2 Family Tree
opened at the New Family Wizard
PREMIER+™ 2 Family Tree will open at the New Family Wizard if the last family file that you were editing is not

available (for example, if you were using a file on a memory stick that has now been removed). Browse to the
folder that contains that family file.

FT027 The picture | want to work with appears too small on the screen

Make sure the PREMIER+™ 2 Family Tree window is maximized by clicking the Maximize icon on the title bar.
Click Zoom To Fit to expand the picture so it fills the work area. Use Zoom In if you are working on details within
the picture.

FT028 | find it hard to select the part of the picture | wish to edit

Many functions of PREMIER+™ 2 Family Tree can be used to help see sections of pictures more easily. Use the
Zoom Commands when working on details.

FT030 The lettering or SuperDesigns | am designing in PREMIER+™ 2 Font
Create are not appearing in PREMIER+™ 2 Family Tree
PREMIER+™ 2 Family Tree and PREMIER+™ 2 Font Create cannot have the same font or shapes set open at

the same time. Therefore, you must close the font or SuperDesign set in PREMIER+™ 2 Font Create to make it
fully available to PREMIER+™ 2 Family Tree.



FT031 | want to change the appearance of the font stitching, but the Stitch Type
drop-down is not available.

If the Stitch Type area is grayed out (unavailable), this means that the area was designed with properties cannot
be edited. For example, this occurs with Foam fonts that have special settings to ensure the embroidery foam is
cut, and it also occurs with a few very complex fonts that have many different fill patterns in different letters, or
multigradient fills, such as Acorn 6C UC 35-60mm in the Floral category.

You may wish to use a different font with a similar style that allows you to change its properties, or create a new
font with the QuickFont Wizard based on a TrueType® or OpenType® font with a similar style.

FT032 | have increased the Gap setting, but the lowercase characters are still
touching each other

For script fonts, the Gap setting has no effect on adjacent lowercase characters. Script fonts use a special
‘continuous' joining method, which places lowercase characters adjacent to each other to give the appearance of
handwriting. All the fonts in the Script category use this joining method, and you may also create new fonts with
the PREMIER+™ 2 QuickFont Wizard or the optional PREMIER+™ 2 Font Create module that use this joining
method.

FT033 | get an 'exception report' warning when importing my family tree into
Family Historian

If you have used the "Resides At" attribute within your family tree, Family Historian will generate an error message
when the GEDCOM file for that family tree is imported: "An exception report has been generated which lists all
data lines (if any) that have been skipped (i.e. not loaded)..."

This happens because Family Historian version 3.1 does not fully support the RESI attribute.

FT034 Some characters in my text changed when loading a .ged file created in
another program

PREMIER+™ 2 Family Tree uses the ASCII character set. When a family tree (.ged) file is loaded, some
accented characters may be changed if a non-ASCII character set is used. This happens because the way that
accented and special characters are represented varies between character sets.

Where possible, export the file again from the original program, using the ASCII character set. Otherwise, check
the imported family information and, where necessary, edit the family tree information.

FT035 Why has the file association for .ged files been removed from
PREMIER+™ 2 Family Tree?

When some other genealogy programs open a .ged file, the file association is automatically taken back. You will
still be able to open the .ged file from within PREMIER+™ 2 Family Tree.

In these circumstances, to open a .ged file with PREMIER+™ 2 Family Tree, right-click the file, select "Open
with", and select PREMIER+™ 2 Family Tree from the menu.

You can select to automatically open .ged files with PREMIER+™ 2 Family Tree from the same menu. However,
the next time you use the other genealogy program the file association will switch back.

FT036 "Error. No family data found. Cannot open .ged file."

The family tree (.ged) file cannot be read. Export the file again from the original program. You may need to adjust
your export settings.

Note: This error message may be reported when importing GEDCOM files from other family history programs.



GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA008 "Embroidery XY coordinates incorrect"

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."



This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
o System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.



GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA034 "Error saving picture."

This message appears on attempting to save the picture and the picture is not saved. For example, if you attempt
to overwrite an existing picture that is read only or if you attempt to save the picture to a read only location such
as a CD-ROM.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 When | press the Help button I get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check



Installation button and clicking Check to see which items you have installed.
Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA054 "Error. This scanned image type is not supported.”

This message will appear if the scanner has created an image file that is not supported by the PREMIER+™ 2
module. Convert the image to a supported image file format.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE003 "Motif database is missing or corrupt. Cannot change motif."

This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb' from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.



Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 \Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDirive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "I do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

Ge032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GEQ30
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:



Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
Add info@embroiderynewsletter.net to your email Contacts or Address Book.

Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "l do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.
4. In the menu on the left, click Account Password.
5
6

. Enter your old password at the top, followed by your new password twice.
. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.



IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.



wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso10 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format’. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
IOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Font Create

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco16 How do | backup my PREMIER+™ 2 settings?



To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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cso006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

Dcoo1 \What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

Dco03 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

. Position the pointer over the icon in the system tray and right-click. A menu will appear.

. Click the Start Automatically option.

. Right-click the icon again to confirm the Start Automatically option is checked.

. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

—
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EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.



However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

ED001 "Some areas were too thick to be traced."

This message may appear when creating an Express Trace design if the final picture has thick areas of solid
color. Some or all parts of the design may not be created. Try using options in the wizard, on the Outline Finder
and Expander page and/or the Monochrome Threshold page, to ensure the outlines are not too thick. Cancel the
wizard, adjust the picture so that the outlines are easier to isolate with Monochrome Threshold, then open the
picture in the ExpressDesign Wizard again.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EmMo010 "Error. Font file is corrupt.”

This message appears when trying to select or use a lettering style if the file has corrupted. Reinstall the font.

This may also appear if a font is created in PREMIER+™ 2 Font Create and has no characters defined. Use
PREMIER+™ 2 Font Create to define at least one character in the font.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM111 In Font Manager one of the fonts in My Fonts shows a Minimum and
Maximum size of 0.0 mm.

In the Font Manager dialog box a font that was created in QuickFont Wizard in PREMIER+™ Embroidery or in
PREMIER+™ Font Create, and copied to your My Fonts folder, may show a minimum and maximum size of 0.0
mm. This does not affect the use of the font.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors



If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created
Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has

more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2". and so on.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
o System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.



This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA018 | can't see some of the floating toolbars or icons

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.

AR ON -

(o]

If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.



GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE003 "Motif database is missing or corrupt. Cannot change motif."



This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb’ from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDirive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:
1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)




2. Select 'l do not have a previous registration' and then click Next.
3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

» Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
« Add info@embroiderynewsletter.net to your email Contacts or Address Book.

» Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
» Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:
1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)




2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.
5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HMo001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16 Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.



3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
IOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser




Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Modify

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco16 How do | backup my PREMIER+™ 2 settings?

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...eftc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.

o~NO O~

cco18 How can | view embroideries within zipped files?

To view an embroidery within a compressed (zipped) file, browse into the compressed file in Explorer, open the
Preview pane, and click to view the selected embroidery.

cso006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.



You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM021 It seems to take a long time to redraw embroideries when | choose
different functions or switch to a new embroidery

The refresh rate of the screen is limited by the power of your computer's processor and RAM as well as the video
card and its memory. To get the best performance from your system, try using 2D view as this requires less power
than 3D view.

EM022 Some of the icons in the toolbar are 'grayed out'.

Certain icons (for example Save and Export on the Quick Access Toolbar) are only highlighted once an
embroidery is shown on the screen.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM048 \When | hover the mouse pointer over a color in the color worksheet, part
of the embroidery changes to an unusual color.



This is called "Highlight Selected Color". It allows you to see where each color is used in an embroidery. For
example, if you have several color blocks using the same thread color and you wish to change the color of a
specific section, hover over each color in the worksheet in turn until the section you require is highlighted.

EM112 Send to Machine via mySewnet™ and PREMIER+™ 2 version 12.4 for
Windows®

The Send to Machine via mySewnet™ feature for sending designs to the HUSQVARNA VIKING Designer EPIC™
and the PFAFF creative icon™ is not currently working in PREMIER+™ 2 version 12.4 for Windows®. This issue
does not affect PREMIER+™ 2 version 12.4 for Mac®.

As a temporary workaround, you can use Send to mySewnet™ and then browse to the file on your machine.

A fix for this issue is being worked on.

GA001 | can't drag and drop embroideries from the Open dialog box

To drag and drop embroideries onto the Work Area, open Windows® Explorer. Then follow the instructions under
Drag and Drop.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt"

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.



GA008 "Embroidery XY coordinates incorrect”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

« User.sqlite
» System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue



Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA018 | can't see some of the floating toolbars or icons

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. Amessage will appear, indicating that all modules will be closed and reset. Click OK.

. Amessage will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA019 "The color xx has been found in your database, but the thread color is not
exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA024 | have a very large embroidery in the clipboard block. How do | remove
it?

Click on the Clipboard Block to clear the current contents.

GA027 "Embroidery too large for export format."



Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct

thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA049 When | double click on my stitch files, they now open in another software.
How can | reset the file associations?

It may be that you installed another software which is now associated with your stitch files.
To reset the association back to the PREMIER+™ 2 Embroidery System do the following steps:

1. Close down all programs.

2. Open PREMIER+™ 2 Configure.

3. Click the Reset File Association button. A Reset File Association box will appear.
4. Click on the PREMIER+™ 2 Embroidery button in the Reset File Association box.
5. The Set Program Association page will appear.



6. Click on the Select All checkbox. All stitch formats will be selected in the list.
7. Click Save.

All the selected stitch formats will have been set back to open in PREMIER+™ 2 Embroidery.

GA055 "Error. Shapes database is corrupt or missing."
This message usually means that the shape database has been accidentally moved, deleted or corrupted. This
may be corrected by repairing the installation.

This error does not prevent the PREMIER+™ 2 module from starting. However, you will not be able to use the
relevant functions until this is resolved.

To correct this, start the installation for your PREMIER+™ 2 Embroidery System software, then choose the Repair
option.

If the problem persists, delete the file named 'BorderShapes.bdr' from
ProgramData\VSMSoftware\Premier+2\System, and then use the Repair option again.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error.

Repair an Installation of the PREMIER+™ 2 Embroidery System

1. Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.)

2. When the choice appears, select the "Modify or remove" option and click Next.

3. In the next screen, select Repair and click Next.

4. Continue with the installation and follow the on-screen instructions.

When the installation is complete, the shapes database will be restored.

GA056 The From Scanner or Camera option is not available, even though my
scanner/camera is plugged in.

The From Scanner or Camera option may not be available, even though you have installed and connected a
scanner/camera, if it does not support Windows Image Acquisition (WIA). If your scanner/camera supports a
different image acquisition system, e.g. TWAIN, create a .png or .jpg file of the image in My Pictures, and load it
from there.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE003 "Motif database is missing or corrupt. Cannot change motif."

This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb' from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.



Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when itis in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net




You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GEQ30
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
Add info@embroiderynewsletter.net to your email Contacts or Address Book.

Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:



1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin



Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

SeE001 When | view Tajima files, the Trim and Stop stitches do not show

Unlike Husqgvarna Viking/Pfaff (.vp4 and .vp3) format files, Tajima (.dst) does not have stitches specially
designated as trims or stops. Instead these are replaced as three extra jump stitches instead of a trim and a color
change instead of a stop. When the machine is stitching the design, it converts these back to the correct stitch

types

SE002 The embroidery | want to work with appears too small on the screen

Make sure the PREMIER+™ 2 Modify window is maximized by clicking the Maximize icon on the title bar, then
maximize the window of the desired embroidery by clicking the Maximize icon on its title bar. Click Zoom To Fit to
expand the embroidery so it fills the window or use Zoom In together with the Overview Window to move around
the embroidery. Check the Hoop Size in Hoop Selection to make sure the Hoop Size is not too large for the
embroidery.

Se003 | find it hard to select the part of the embroidery | wish to edit

Many functions of PREMIER+™ 2 Modify can be used to help see sections of embroideries more easily. They
include the Zoom Commands and the Overview Window, as well as Draw Next Color, Draw Previous Color, the
slider bars and Ghost Mode. The Coordinates can also be used to help run through designs to find the required
stitch or command. The different methods of selection (Box Select, Color Block Select, Freehand Select,
Freehand Point Select and Select All Visible) are also useful for different situations.

SE004 | selected part of an embroidery, then tried to Compensate the block. The
compensation has been applied to the whole embroidery, not just the area
selected.

Compensation works on the visible part of an embroidery. Hide stitches with Draw Range, Draw Next Color or
turn colors off by right-clicking in the Color Worksheet to isolate a specific area before using this function.

SE005 | selected part of an embroidery, then tried to Break Up Stitches. Stitches
have been broken up in the whole embroidery, not just the area selected.

Break Up Stitches works on the visible part of an embroidery. Hide stitches with Draw Range, Draw Next Color or
turn colors off by right-clicking in the Color Worksheet to isolate a specific area before using this function.

SE006 | cannot select the desired color using the Color Block Select function,
because one color is on top of the other

Use Draw Next Color and Draw Previous Color or turn colors off by right-clicking in the Color Worksheet to isolate
the desired color area, then click Color Block Select to select those stitches.

SE007 | used Box Select around an area, but selected some stitches | didn't
want. Undo is grayed out so | can't click it.



To cancel a stitch block selection made using Box Select, Color Block Select, Freehand Select, Freehand Point
Select or Select All Visible, click anywhere in the currently active embroidery, but outside the box showing the
selected stitches. The stitches will no longer be selected.

SE008 | have started to Emboss an embroidery using the Stamp Fill and realize |
have not isolated the part of the design | wish to pattern

Click Undo once the stamping process is complete, then isolate the desired stitches and use Stamp Fill again. If
necessary, click Undo once more to Undo the use of Remove Needle Points in Fill.

SE011 Error "The cut line crosses over itself. Please define another cut line and
try again.”

This message appears when you place a cut line that crosses itself at some point. If you want to split the
embroidery then you must redo the cut line, without it crossing over itself.

SE013 Error "The cut line does not enter the embroidery. Please define another
cut line and try again."

This message appears when you right-click to end the cut line before the cut line has crossed any stitches. If you
want to split the embroidery then you must redo the cut line.

SE014 It seems to take a long time to redraw embroideries when | choose
different functions or switch to a new embroidery.

The refresh rate of the screen is limited by the power of your computer's processor and RAM as well as the video
card and its memory. To get the best performance from your system, keep the Overview Window closed, as this
must be redrawn every time the screen changes. Also try using 2D view as this requires less power than 3D view.

SE015 Some of the icons in the Ribbon bar are 'grayed out'

Certain icons (for example Copy and other Home tab icons) are only highlighted once an embroidery is shown on
the screen.

SE017 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color dropdown on the Grid Color button.

Go to the Grid section of the toolbar (on the View tab) to change the grid spacing. Set the Grid Size to 5.

SE018 | have moved the Design panel and | can't put it back in position

If the Design panel is 'floating' on top of the window, double-click the title bar and the Design panel will move back
to its original position.

If the Design panel is docked on the wrong side of the window, click and drag the title bar to the middle of the
right-hand edge of the window until the outline snaps into position on the right. Release the mouse button and the
control panel will be dropped into its original position.

Using Reset All Modules in PREMIER+™ 2 Configure will also return the control panel to its original position.
To use Reset All Modules
1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.



2. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

3. Click Reset All Modules.

4. A message will appear, indicating that all modules will be closed and reset. Click OK.

5. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

6. A message will appear, indicating that all modules have now been reset. Click OK. The control panel will
have been restored.

SE019 The Design panel is not showing or is in the wrong position in
PREMIER+™ 2 Modify.

If the Design panel is visible but in the wrong position, first try to click and drag its title bar to move it back to its
normal position on the right.

If this does not work, or the Design panel is not visible, use Reset All Modules.

Note that Reset All Modules affects all modules in the PREMIER+™ 2 Embroidery System, so any changes to
settings in each module will be reset. The recent files list on the File menu is also cleared, but this does not affect
any files you have saved.

To use Reset All Modules:

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

2. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

3. Click Reset All Modules.

4. A message will appear, indicating that all modules will be closed and reset. Click OK.

5. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

6. A message will appear, indicating that all modules have now been reset. Click OK.

The next time you start PREMIER+™ 2 Modify, the Design panel will be in the correct position.

SE020 "Error. Not enough cut points to separate the embroidery."

This message appears when you place only two points to define your cut line. You must place at least three
points to define the area that will be separated.

SE022 The points on my border shape are blunt.

This may happen with some border shapes that have sharp points if they are not drawn proportionally, or if you
create very sharp points with Freehand Tablet or Point Border. This may also happen when border shapes are
used at very small sizes.

For best results when drawing preset shapes with sharp points, it is recommended to hold down Citrl so that the
shape is perfectly in proportion.

When using Freehand Tablet or Point Border, if you need to have an acute angle, try placing an extra point or two
around the turn, instead of using a single point. Also, try to join the polygonal border back to itself on a straight
side. If the border starts and finishes at a corner, that corner will not be mitered because the ends of the border
will be flat at that point.

SE023 After drawing a border/appliqué shape, | right-click but the shape
disappears.
When drawing border/appliqué shapes, right-click is used to cancel without using the shape. To use the shape,

you must click one of the Create Border or Create Appliqué functions. This then creates a new embroidery with
the border or appliqué.

When drawing a Border Shape, the border shape using right-click will cancel without using the shape.
Use one of the Create External Border, Create Internal Border or Create Overlay Border functions.



SE024 Error: "This design contains design information that would be fixed as
embroidery stitches; for example, Lettering or SuperDesigns. Do you wish to
continue?"

This message may appear if you open a .vp4 file containing lettering or SuperDesigns in PREMIER+™ 2 Modify,
as they will be fixed as stitches. Save the embroidery under a new name if you want to keep a copy of the
original.

If desired, you can turn this message off in Preferences.

SE025 Error: "Embroidery is too large or will not fit in the hoop."

This message appears if an embroidery you are trying to Export is outside the selected hoop or larger than will fit
in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x 100mm might
be placed partially outside the work area when you click Export. This message would then appear.

Move the embroidery completely within the four blue corners of the work area and try again.

SE026 Error: "No embroideries available to print. Only embroideries that are
inside the hoop can be printed."

This message appears if the embroidery on screen is partially outside the selected hoop.
Move the embroidery completely within the four blue corners of the work area and try again.

SE027 "When using Border Embroidery only the Create Overlay Border option is
available."

This may happen with some embroideries containing holes or appliqué areas. Where multiple lines are found,
there cannot be a single external or internal border, so only the Create Overlay Border option is available for use.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?



The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 PhotoStitch

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 / Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...etc.

O ~NO O~



** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.

cso006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

Dcoo1 What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

DC003 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

DC022 Error "You must select an area first, before applying the crop tool."

Use the Box Select feature to select an area of the Picture around which you wish to crop the background.

Dco023 Error "Cannot rotate - picture will be bigger than 2000 x 2000 pixels if
rotated to this extent.”

When rotating a picture, certain angles could make the picture larger than the maximum allowed. If this message
appears, either rotate the picture to a different angle, or reduce the size of the picture, then try again.

DC048 | am trying to Resize an area, but nothing happens when | click the
Resize icon or select Resize from the Picture menu

To resize when part of a picture is selected, simply click and drag any of the resize handles on the selection box
(out to increase size, in to decrease size). When the mouse is over a resize handle on a corner of the selection
box, the pointer changes from an arrow to the resize pointer.

DC049 | am trying to Rotate an area, but nothing happens when | click the Rotate
icon or select Rotate from the Picture menu

To rotate when part of a picture is selected, simply click and drag the round rotate handle on the middle right of
the selection box. Click and drag down to rotate clockwise, up to rotate counterclockwise.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.
2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.



3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM021 It seems to take a long time to redraw embroideries when | choose
different functions or switch to a new embroidery

The refresh rate of the screen is limited by the power of your computer's processor and RAM as well as the video
card and its memory. To get the best performance from your system, try using 2D view as this requires less power
than 3D view.

EM022 Some of the icons in the toolbar are 'grayed out'.

Certain icons (for example Save and Export on the Quick Access Toolbar) are only highlighted once an
embroidery is shown on the screen.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EmM081 | would like to remove the lines created from the white background of my
picture by Linear PhotoStitch embroidery.

After creating and saving an embroidery, use the Edit tab in PREMIER+™ 2 Embroidery Extra, or open the file in
PREMIER+™ 2 Modify, and use the following instructions.

1. Use the Freehand Point Select feature to mark the stitches in the background.
2. Click the Delete button.



3. Save the adjusted embroidery.

EM082 Could not load picture file.

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a USB memory stick, then closed and the memory stick removed. It could also appear if the file you
are attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a
proper picture file.

EM110 | would like to get rid of the stray stitches in the background of my
PhotoStitch embroidery

It is best to clean the background of a picture so that there are no flecks, as they can cause stray stitches. If some
remain in a saved PhotoStitch embroidery, remove them in the Modify tab or open the file in PREMIER+™ 2
Modify and use the following instructions.

1. Use one of the Select features to select the stray stitches.
2. Click Delete Stitches.
3. Save the adjusted embroidery.

FT011 "The selected dimensions will produce a large PhotoStitch and stitch
creation may take some time. Removing background areas will reduce the time
required.”

This message will appear if you specify a PhotoStitch larger than 26,000mm square. Click OK to continue
creating the PhotoStitch. To reduce the stitch creation time, remove the picture background, particularly any very
detailed areas. Stitch creation time is shorter for Linear PhotoStitch.

FT016 Error "The color xx has been found in your database, but the thread color
is not exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.



GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"1", "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt”

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA011 Error "Not enough memory to perform operation."

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
» System_cdb2.sqlite



This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. Amessage will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. Amessage will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.



GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA028 The toolbar icons have unexpectedly changed to a smaller size.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings
(see GAQ18).

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

GA034 "Error saving picture."”

This message appears on attempting to save the picture and the picture is not saved. For example, if you attempt
to overwrite an existing picture that is read only or if you attempt to save the picture to a read only location such
as a CD-ROM.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:



1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA049 When | double click on my stitch files, they now open in another software.
How can | reset the file associations?

It may be that you installed another software which is now associated with your stitch files.
To reset the association back to the PREMIER+™ 2 Embroidery System do the following steps:

. Close down all programs.

. Open PREMIER+™ 2 Configure.

. Click the Reset File Association button. A Reset File Association box will appear.
. Click on the PREMIER+™ 2 Embroidery button in the Reset File Association box.
. The Set Program Association page will appear.

. Click on the Select All checkbox. All stitch formats will be selected in the list.

. Click Save.

All the selected stitch formats will have been set back to open in PREMIER+™ 2 Embroidery.
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GA050 "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close the PREMIER+™ 2 module, follow the manufacturer's instructions for the WIA-compliant device,
then reopen the PREMIER+™ 2 module and try again.

GA051 "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the WIA-compliant device. Close the PREMIER+™ 2 module and the other graphics
program, then reopen the PREMIER+™ 2 module and try again.

GA052 Error message "Your scanner or camera is no longer available for use.
Close this program, plug in and switch on your scanner or camera, and run this
program again."

This message will appear if the connection to your scanner or digital camera has a problem. Close the

PREMIER+™ 2 module, check the connections to your scanner or digital camera, then reopen the PREMIER+™
2 module and try again.

GA053 Error message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close the PREMIER+™ 2 module, check the
connections to your scanner or digital camera, then reopen the PREMIER+™ 2 module and try again.

GA054 "Error. This scanned image type is not supported.”

This message will appear if the scanner has created an image file that is not supported by the PREMIER+™ 2
module. Convert the image to a supported image file format.



GA055 "Error. Shapes database is corrupt or missing."
This message usually means that the shape database has been accidentally moved, deleted or corrupted. This
may be corrected by repairing the installation.

This error does not prevent the PREMIER+™ 2 module from starting. However, you will not be able to use the
relevant functions until this is resolved.

To correct this, start the installation for your PREMIER+™ 2 Embroidery System software, then choose the Repair
option.

If the problem persists, delete the file named 'BorderShapes.bdr' from
ProgramData\VSMSoftware\Premier+2\System, and then use the Repair option again.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error.

Repair an Installation of the PREMIER+™ 2 Embroidery System

1. Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.)

2. When the choice appears, select the "Modify or remove" option and click Next.

3. In the next screen, select Repair and click Next.

4. Continue with the installation and follow the on-screen instructions.

When the installation is complete, the shapes database will be restored.

GA056 The From Scanner or Camera option is not available, even though my
scanner/camera is plugged in.

The From Scanner or Camera option may not be available, even though you have installed and connected a
scanner/camera, if it does not support Windows Image Acquisition (WIA). If your scanner/camera supports a
different image acquisition system, e.g. TWAIN, create a .png or .jpg file of the image in My Pictures, and load it
from there.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."



This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030



» To check if you are subscribed, see GE031
To ensure that you are receiving the Newsletter, do as follows:

» Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
» Add info@embroiderynewsletter.net to your email Contacts or Address Book.

» Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
» Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.
2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.
4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".
5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "l do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example 1,&?).

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.



IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

IN016  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

PS100 "You must select an area first, before applying the Red Eye tool."

The Red Eye tool can only be used in a selected part of the picture, not over the whole picture. Select the
required part of the picture with one of the selection tools (the Ellipse Select tool usually works best), then use the
Red Eye removal tool.

Ps101 "Error. Cannot open Font File."

This message appears if the frames or corners set that you have selected is not available.



This could happen if you opened the PREMIER+™ 2 PhotoStitch program, then accidentally moved or deleted
the file from ProgramData\VSMSoftware\Premier+2\Frames\Frames or Corners.

Close PREMIER+™ 2 PhotoStitch, make sure the file is in the folder, then try again.

PS102 Error: "Embroidery is too large or will not fit in the hoop."

The embroidery is too large for your currently selected hoop. Click OK and select a bigger hoop before stitching
out, or make a smaller embroidery from the currently loaded picture.

PS103 "l can’t change my embroidery hoop."

The Hoop Selection dialog is only available when you are in the Stitch Window. You cannot open it in the Picture
Window.

PS104 The picture | want to work with appears too small on the screen

Make sure the PREMIER+™ 2 PhotoStitch window is maximized by clicking the Maximize icon on the title bar.
Click Zoom To Fit to expand the picture so it fills the work area.

Use Zoom To Rectangle or the Zoom Bar if you are working on details within the picture.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
iIOS or Android device?



Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 QuickFont

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

The sizes of the shapes in a symbol font often vary in size within a single font. The size of converted fonts is set
by specifying the height of the uppercase letter A, or whichever symbol or character occupies its position in the
font (ASCII character 65). This may affect your converted symbols if the symbol at ASCII 65 is a lot smaller or
larger than other symbols in the font. If your symbols convert to unexpectedly small or large sizes, compare the
symbols by selecting the font in a word processor and typing on your keyboard. Type in A and some other letters
to see how the corresponding shapes differ in size from the shape for A. Alternatively, type in some letters in a
normal font then select the letters and change them to the required symbol font.

There is a free word processor called WordPad supplied with all current versions of Windows®.

This message may appear when trying to preview or create a font with the QuickFont Wizard. When some parts
of characters have very narrow sections, they may not be large enough to have fill areas created when the Stitch
Type is set to Fill or Fill + Satin Border. If the font is created, it may have characters or parts of some characters
missing. It is recommended to choose a different Stitch Type. Alternatively, create the font then use PREMIER+™
2 Font Create to create the missing parts and/or characters

This message may appear during font creation if one or more characters is not properly defined in a font. That is,
there is no data in the TrueType® or OpenType® font about the characters, so they cannot be created in the
embroidery font. This may happen with specialist or symbol fonts, which are not designed for general text usage.
Click Yes to continue and create the available characters, or click No to cancel creating the font and choose a
different TrueType® or OpenType® font.



To backup your PREMIER+™ 2 settings:
Backing Up MySettings:

1. Open PREMIER+™ 2 Configure.

2. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

3. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 /| Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...eftc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

. Start PREMIER+™ 2 Configure.

. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

. Position the pointer over the icon in the system tray and right-click. A menu will appear.

. Click the Start Automatically option.

. Right-click the icon again to confirm the Start Automatically option is checked.

. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.
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This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

The MyFonts folder for the Premier+ Embroidery System, can be found here:
Windows® 7 / Windows® 8 / Windows® 10 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\MyFonts

If you do not see the ProgramData folder; then you may have to take the following steps to stop them being
hidden by your operating system:

1. Click on your Start menu.

2. Click on Control Panel.

3. Type folder option into the Search textbox

4. Click on the Folder Options link.

5. The Folder Options dialog box will appear — set it to Show hidden files, folders and drives files and
uncheck the two Hide options indicated in the screenshot — click Yes to the warning message.



6. Click OK.
7. Once you have followed all the instructions for accessing the MyFonts folder, you can reverse these
instructions to put the Folder Options to what they were.
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EQ001 | can't select a font that is on my
computer.

| Hide peotected oparating system files (Recommended) The QuickFont Wizard is designed to work with Windows
TR TrueType® and OpenType ® fonts. The QuickFont Wizard
does not support Postscript Type 1 fonts. To check Font
Rastors Defats. | Properties:

= _ '1|. Click Start, Control Panel, then select Fonts.

0% || Cmesl || ey 2 Click the desired font to select it.

. Right-click and select Properties from the menu that appears.
4. Check the Type of file section. If it is PostScript Metrics or

Type 1 Font File it will not work with the QuickFont Wizard.
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EQ002 "Error. Could not set up font data."

This message may appear at the end of font creation with the QuickFont wizard if one or more characters is not
properly defined in a font. That is, there is no data in the TrueType or OpenType font about the characters, so they
have not been created in the embroidery font. This may happen with specialist or symbol fonts, which are not
designed for general text usage. If desired, use PREMIER+™ 2 Font Create to create any missing characters.

EQ003 "Error. Font is too thin to be filled."

This message may appear when trying to preview or create a font with the QuickFont Wizard. When some parts
of characters have very narrow sections, they may not be large enough to have fill areas created when the Stitch
Type is set to Fill or Fill + Satin Border. If the font is created, it may have characters or parts of some characters
missing. It is recommended to choose a different Stitch Type. Alternatively, create the font then use PREMIER+™
2 Font Create to create the missing parts and/or characters.

EQ004 Why do | receive the "Error. Font character too complicated" message in
QuickFont Wizard?

This can happen if you have selected a very small (or complex) TrueType Font that is installed on your computer.

If a particular character is extremely small; then some of the narrower sections of a character will not be large
enough to contain a Satin/Fill area. This may result in that character not being generated.

For example when trying to generate the Garamond font; by default the 'e' character is too small to generate -
resulting in the following message



GuickFont Wizard B3|

i l- ' Font generation stopped at character 'd' (Asdi code 100)
e An error occurred while processing the following characters:

& (Asci code 101) - Error. Font character is too complicated.

——

A way around this is to increase DPI settings on your computer (the size that your Operating System displays
your fonts at):

The image below gives an approximation of moving from normal (left) to Large (right)
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Windows 7

1. Right click on an empty area of your Desktop.

2. Click on the Screen resolutionoption. The Screen resolution appears
3. Click on the Make text and other items larger or smaller option.

4. Choose the Medium (or Larger) option.

5. Click Apply. Restart your computer if prompted.

EQ005 Error: "Font is too thin, wouldn't do fill."

This message may appear when trying to preview or create a font with the QuickFont Wizard. When some parts
of characters have very narrow sections, they may not be large enough to have fill areas created when the Stitch
Type is set to Fill or Fill + Satin Border. If the font is created, it may have characters or parts of some characters
missing. It is recommended to choose a different Stitch Type. Alternatively, create the font then use PREMIER+™
2 Font Create to create the missing parts and/or characters.

GA010 Error "Unrecognized file extension" when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.

GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:



« User.sqlite
» System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. Amessage will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. Amessage will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.



The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE026 Feature not available in this version.
This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser



is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when itis in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:
» Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.



« Add info@embroiderynewsletter.net to your email Contacts or Address Book.
« Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
» Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HMo001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?



You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 \Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?



On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
iIOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Sketch

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco16 How do | backup my PREMIER+™ 2 settings?

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:
1. Open PREMIER+™ 2 Configure.



. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 /| Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...eftc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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cco18 How can | view embroideries within zipped files?

To view an embroidery within a compressed (zipped) file, browse into the compressed file in Explorer, open the
Preview pane, and click to view the selected embroidery.

cso006 Error message "You can't save here. Please choose another location."

This message appears if, for instance, you attempt to save the design to a CD. A CD-R is read only, therefore you
will not be able to save the design.

Dcoo1 \What DPI setting should | use to scan a picture for creating a design?

The correct DPI (dots per inch) setting will depend on the size of the picture to be scanned. The desired picture
size is approximately 1500 X 1500 pixels. To achieve this take the size of your artwork in inches, such as 8" x 7",
and divide the longest side into 1500. In the example, 1500 divided by 8 = 187.5. The DPI setting of the scanner
should then be 188 DPI, and this will produce a picture that is about 1500 x 1310 pixels.

DCco03 | loaded a small picture, and it has too many jagged lines

Although the program automatically doubles the size of a picture if its height and width are less than 500 pixels,
this may still produce jagged lines. For a smoother effect, rescan the picture.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

. Start PREMIER+™ 2 Configure.

. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

. Position the pointer over the icon in the system tray and right-click. A menu will appear.

. Click the Start Automatically option.

. Right-click the icon again to confirm the Start Automatically option is checked.

. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.
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EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?



You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.

EM002 "Error: Please select a valid thread."

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

EM011 Error: "Embroidery is too large or not in the hoop"

This message appears if an embroidery you are trying to Export or Print is outside the selected hoop or larger
than will fit in it. For example, with the 100mm x 100mm hoop selected, an embroidery smaller than 100mm x
100mm might be placed partially outside the work area when you click Export or Print. This message would then
appear. Move the embroidery completely within the four blue corners of the work area and try again.

EM017 "Embroidery has too many stitches for file format."

There is a limit on the number of stitches that may be saved to an embroidery file in Pfaff (.pcs) file format. This
message appears if the embroidery you attempt to save to this format exceeds this limit.

EM021 It seems to take a long time to redraw embroideries when | choose
different functions or switch to a new embroidery

The refresh rate of the screen is limited by the power of your computer's processor and RAM as well as the video
card and its memory. To get the best performance from your system, try using 2D view as this requires less power
than 3D view.

EM022 Some of the icons in the toolbar are 'grayed out'.

Certain icons (for example Save and Export on the Quick Access Toolbar) are only highlighted once an
embroidery is shown on the screen.

EM023 | have changed grid color and spacing and now | wish to return to the
original settings

Use PREMIER+™ 2 Configure to change the grid color. Follow the instructions in PREMIER+™ 2 Configure and
select Blue Gray (RGB values 100, 102, 153) from the standard color drop-down on the Grid Color button.

Use Screen Preferences to change the grid spacing. Set the Grid Size to 10.

EM082 Could not load picture file.

This message could appear if the desired picture is not where the module expects it to be, for example if it was
loaded from a USB memory stick, then closed and the memory stick removed. It could also appear if the file you
are attempting to load is corrupt. For example, it might have an extension such as .bmp or .jpg, yet not be a
proper picture file.

GA001 | can't drag and drop embroideries from the Open dialog box



To drag and drop embroideries onto the Work Area, open Windows® Explorer. Then follow the instructions under
Drag and Drop.

GA002 Error: "Embroidery too large for output file format"

Certain formats are limited to the size of hoop used on their specific embroidery machine, for example .sew. If you
attempt to Export a file in this format that is bigger than the largest available hoop size this message would
appear.

GA003 | have saved my embroidery as Tajima format, but it now has more colors

If your original embroidery had a stop command in it then this would be replaced by a color change, thus adding a
color for every stop you have in your embroidery. As the Tajima file format does not have a stop command in its
format, it requires the machine operator to manually enter stops into the machine. If you save or distribute files in
Tajima format, then you must also specify all colors and stops and where they occur in the embroidery.

GA004 | have saved an embroidery in .sew format, and two files have been
created

Janome software cannot load embroideries with more than 12 colors. If a file to be exported in .sew format has
more than 12 color changes, it will automatically be split into multiple files, with the last character of the filename
"q" "2", and so on.

GA005 Error "Cannot open embroidery."

This message appears if the desired embroidery is not where the module expects it to be, for example if an
embroidery was loaded from a USB memory stick, then closed and the memory stick removed. The message
would appear if you tried to load the embroidery from the Recent Files list on the File menu.

GA006 Error "Unrecognized file format."

This message appears if the file you are attempting to load is corrupt. For example, it might have the extension
.vp4, yet not be a proper Husqvarna Viking / Pfaff embroidery.

GA007 "Embroidery is corrupt"

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA008 "Embroidery XY coordinates incorrect"

The embroidery is corrupt and cannot be loaded. Refer to source of this file for a solution.

GA009 "Unrecognized file extension"

This message appears if you attempt to load a file with an extension that does not belong to any embroidery file
types. For example, it would appear if you tried to drag and drop a .doc file onto the screen.

GA010 Error "Unrecognized file extension"” when saving a file

This message appears if you type an incorrect extension that does not belong to any embroidery file types in the
File Name box when trying to save a file.



GA012 Error - thread range is corrupt or missing. Cannot change thread. Restore
MySettings or reinstall the thread database."

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

o User.sqlite
« System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

GA013 Error: Please select a valid thread.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

GA015 | have changed the screen background color and now | wish to return to
the original light blue

Use PREMIER+™ 2 Configure to change the background color. Follow the instructions in PREMIER+™ 2
Configure and select the RGB values 211, 233, 255 in the Colors dialog box.

GA018 | can't see some of the floating toolbars or icons

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

. Click Reset All Modules.

. A message will appear, indicating that all modules will be closed and reset. Click OK.

. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.

. Amessage will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.
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If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA019 "The color xx has been found in your database, but the thread color is not
exactly the same."

This message appears if the Thread Range and Color Number of the selected color are identical to those in your
thread database, but some aspect of the color is different. It could be a different material or weight, or have
additional colors as a variegated thread. This could happen if the design you are attempting to edit was supplied
by someone with a different version of the color, for instance if they have edited it in MyThreads, or if they have a
later version of the thread database.

If you click OK, the color will be replaced with the near match. You can alter it to any other color if desired. If you
click Cancel, the color will not be changed. To import the new color from an embroidery if it is a MyThreads color,
use PREMIER+™ 2 Thread Cache. To check for the latest updates for the PREMIER+™ 2 Embroidery System,

use Smart Update in PREMIER+™ 2 Configure.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA027 "Embroidery too large for export format."

Certain formats are limited to the number of stitches they can save or the size of hoop used on their specific
embroidery machine, for example .sew. If you attempt to save a file in this format that is bigger than the largest
available hoop size or has more stitches than are allowed, this message would appear.

GA028 The toolbar icons have unexpectedly changed to a smaller size.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings
(see GAQ18).

Alternatively, to change the icon size in this module only, select View, Customize, then go to the Options tab and
select the Large Icons option.

GA032 "Please choose a valid motif pattern.”

This message appears if you try to select a motif from My Motifs, and all the motifs have been deleted from My
Motifs. Use PREMIER+™ 2 Create to add at least one motif to My Motifs.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with



only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA044 "No stitch data to save."

This message appears on attempting to save when there is no embroidery on the current window.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.

GA049 \When | double click on my stitch files, they now open in another software.
How can | reset the file associations?

It may be that you installed another software which is now associated with your stitch files.
To reset the association back to the PREMIER+™ 2 Embroidery System do the following steps:

. Close down all programs.

. Open PREMIER+™ 2 Configure.

. Click the Reset File Association button. A Reset File Association box will appear.
. Click on the PREMIER+™ 2 Embroidery button in the Reset File Association box.
. The Set Program Association page will appear.

. Click on the Select All checkbox. All stitch formats will be selected in the list.

. Click Save.

All the selected stitch formats will have been set back to open in PREMIER+™ 2 Embroidery.
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GA050 "Problem with scanner or camera software."

This message will appear when trying to use your scanner or digital camera if the device has not been installed
correctly. Close the PREMIER+™ 2 module, follow the manufacturer's instructions for the WIA-compliant device,
then reopen the PREMIER+™ 2 module and try again.



GA051 "Scanner or camera is in use by another application."

This message will appear when trying to use your scanner or digital camera if another graphics program is
already open that uses the WIA-compliant device. Close the PREMIER+™ 2 module and the other graphics
program, then reopen the PREMIER+™ 2 module and try again.

GA052 Error message "Your scanner or camera is no longer available for use.
Close this program, plug in and switch on your scanner or camera, and run this
program again."

This message will appear if the connection to your scanner or digital camera has a problem. Close the

PREMIER+™ 2 module, check the connections to your scanner or digital camera, then reopen the PREMIER+™
2 module and try again.

GA053 Error message "Failure to acquire picture due to unknown causes."

This message will appear in certain circumstances when trying to use your scanner or digital camera, for example
if the cable is disconnected during the scan or download. Close the PREMIER+™ 2 module, check the
connections to your scanner or digital camera, then reopen the PREMIER+™ 2 module and try again.

GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE002 "Embroidery not created using licensed software."

This message may appear if you attempt to load an embroidery created in third-party software. Such
embroideries may cause unpredictable results.

GE003 "Motif database is missing or corrupt. Cannot change motif."

This message usually means that the motif database has been deleted or corrupted. This may be corrected by
repairing the installation.

First, delete the file named 'SystemMotifs.mdb' from ProgramData\VSMSoftware\Premier+2\System.

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If the
file is not present then this is the reason for the error. The file name may simply be shown as 'SystemMotifs'.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the installation.
When the choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair
and click Next. Continue with the installation and follow the on-screen instructions. When the installation is
complete, the motifs will be restored.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com



GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDrive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when it is in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select 'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?



You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
Add info@embroiderynewsletter.net to your email Contacts or Address Book.

Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "l do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.

5. Log in to your account with your new password.

To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example 1,&?).



When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

IN016  Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.

IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

SK002 Error message "The program requires a color palette of High Color (16
bit) or higher."
This message appears when attempting to open PREMIER+™ 2 Sketch if your computer is set to a display of
256 colors or less. Reset the display as follows.

1. Right-click on the desktop and a shortcut menu appears.



2. In Windows® 7, click Screen resolution, then click Advanced settings - Properties box will appear. From
there click the Monitor tab.

3. Set the Color quality to High Color (16 bit) or higher using the drop-down menu.

4. Click OK, and allow your computer to restart if required.

SK005 Error message "The Minimum ZigZag Width is larger than the Maximum
ZigZag Width. Change either the Minimum or Maximum so that the Minimum is
the same or smaller than the Maximum."

When setting the Minimum and Maximum ZigZag Width in Stitches Preferences, the Minimum must be the same
or smaller than the Maximum. Adjust either the Minimum or Maximum to ensure that the Minimum is not larger
than the Maximum ZigZag Width.

Skoo6é Some of the icons in the Toolbar are 'grayed out'.

Certain icons (for example, most of the Edit toolbar icons) are only highlighted once there are stitches on the
screen.

SKoo8 Some of the stitches | have drawn with Horizontal ZigZag, Rotational
ZigZag and/or Calligraphy appear to be broken up.

This can happen in 3D view with any of the zigzag stitches when the ZigZag Width is very low. You have drawn
very short stitches close to each other, and this causes them to appear broken up in 3D view. Select 2D view and
you will see the stitches. Hence, this is only an issue with displaying the stitches in 3D.

SK010 The embroidery appears too small on the screen.

Make sure the PREMIER+™ 2 Sketch window is maximized by clicking the Maximize icon on the title bar. Click
Zoom To Fit to expand the hoop so it fills the work area. Also, choose a Hoop Size in the Load Design Wizard or
Hoop Selection that is suitable to the embroidery size.

sko11 | find it hard to select the part of the embroidery | wish to edit.

Many functions of PREMIER+™ 2 Sketch can be used to help see sections of embroideries more easily. They
include the Zoom Commands and hiding thread colors. The different methods of selection (Box Select, Freehand
Select, Freehand Point Select and Select All Visible) are also useful for different situations.

sko12 | have added a Color Change and/or new stitches part way through my

embroidery, instead of at the end.
This happens when you have a stitch point part way through your embroidery selected and Insert Mode is on.
When Insert Mode is on, new stitches and/or color changes are inserted at the selected stitch point. This also

affects stitches added to the embroidery with Paste, and embroideries inserted with Open, Insert and so on. To
ensure you only add stitches and color changes at the end of your embroidery, turn off Insert Mode.

sko13 | used Erase Stitches and some stitches | want to keep are highlighted.

Right-click to finish the Erase Stitches operation. The highlighted stitches will be erased. Click Undo, and the
erase operation will be reversed. Use Erase Stitches again to remove the stitches you wanted to erase, without
removing the stitches you want to keep.

SK014 The page numbers only appear on the worksheet part of the print out.



The plan view and the picture pages only have stitches and the picture on the printed page. This is necessary on
the sheet that prints the picture, so that only the picture is printed onto the printable fabric or tee shirt transfer
paper. Similarly, the plan view should only show the picture and the alignment stitches and/or the embroidery.

SKo15 "No embroidery loaded."

This message appears if you select Finish on the Load Embroidery page of the Load Design Wizard when there
is no embroidery loaded. Load an embroidery so there is an embroidery shown in the preview area. If you do not
wish to load an embroidery, return to the Design Options page and choose a different option.

sko16 "No stitch data to save."

This message appears on attempting to save when there is no embroidery loaded, no alignment stitches have
been created and no stitches have been drawn.

sK017 When | stitch out the embroidery, there is a thick group of stitches in one
place.

This may happen if you pause the pen on the same point on the tablet for an extended time when drawing with
Free Motion, Horizontal ZigZag, Rotational ZigZag or Calligraphy. Each of these drawing functions adds stitches
to the design continuously when the pen is on the tablet (or when the mouse button is held down), as controlled
by the Free Motion Stitch Speed. This is the same as holding fabric in one place in a sewing machine while
continuously stitching. The stitches will be on the same point. You can see this happening as the stitch count on
the status bar increases.

Either select and delete the excess stitches, or remove them with the Eraser.

Alternatively, PREMIER+™ 2 Modify includes a Density Advisor, which can automatically reduce the density
where stitch points are tightly packed together.

SKo18 "l have accidentally made a selection and moved it."

This might happen if the CTRL key is still held down when you have no stitch drawing function selected. When no
other functions are active, stitches can be selected by selecting a stitch, then using CTRL+click to select another
stitch. This will make a selection of all the stitches between the two selected stitches. If no other stitch is selected,
the last stitch in the embroidery is selected. Hence, CTRL+click will select all stitches from the clicked stitch to the
end of the embroidery. To cancel the selection, right-click. If you have moved the selection, click Undo to move
the stitches back to their original positions.

The CTRL key should only be held down if a stitch drawing function is selected. It is recommended to also release
the CTRL key when you right-click to deselect a function.

wso008 Which devices can PREMIER+™ 2 online documentation be viewed
with?
The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows™* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?



On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
iIOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:
Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.

PREMIER+ 2 Thread Cache

Listed versions: 12.0, 12.1, 12.2, 12.3, 12.4, 12.5

cco16 How do | backup my PREMIER+™ 2 settings?

To backup your PREMIER+™ 2 settings:
Backing Up MySettings:
1. Open PREMIER+™ 2 Configure.



. Click on the Backup MySettings button. A 'Save As' dialog box will appear.

. If needed, give the file a descriptive name. Click Save. By default the file will be saved within your
\Documents\Premier+2\SystemBackup folder

. Open Windows Explorer.

. Browse to your Documents folder.

. Double click on the PREMIER+™ 2 Embroidery folder.

. Copy all folders and files - except the Samples folder - to your *external media.

. Browse to the folder which contains your MyFonts folder - see below - and also copy the MyFonts folder to
your external media.

Windows® 7 /| Windows® 8 users: C:\ProgramData\VSMSoftware\Premier+2\Fonts\
* external media: this can be a USB Stick, External USB Hard Disk, burned/copied onto a CD/DVD...eftc.

** The main thing, is not to store backups on the same physical hard disk that your PREMIER+™ 2
Embroidery System is installed on - if that hard disk malfunctioned, then you would lose your
PREMIER+™ 2 software and all of your backups as well.
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cco17 How do | change my personal information for my software registration?

Simply click the Register button in PREMIER+™ 2 Configure and repeat the registration process. This does not
change the registration status of software you have already registered, but it does allow you to change your
personal information and/or dealer information.

cT001 "The thread ABCDE-9999 already exists in MyThreads database. Do you
want to overwrite it?"

This message will appear when you copy a thread from a standard thread range to MyThreads, and the thread
has already been copied.

cT1002 "The Thread Number already exists. The Thread Number field will be set
to a unique value. Please re-edit."

This message will appear if you enter a Thread Number that already exists in MyThreads, when adding or editing
custom MyThreads. Click OK, and an underline and number will be added to the end of the Thread Number to
make it unique. If desired, click in the Thread Number box and re-edit it.

cT003 "This action is permanent and may not be reversed. Do you wish to
continue?"

This message appears if you try to delete a thread definition from a My Thread database, or to delete a My
Thread database. If you wish to go ahead and delete the thread, click Yes. Otherwise click No.

CT006 "You must enter something inside the Thread Number field."

This message will appear when you try to save a new or edited thread if the Thread Number is blank. The Thread
Number may not be blank. Enter a Thread Number and click OK.

cT009 | have a design with My Thread colors that are unmodified copies from
the Standard Thread Database, but they are not in my My Thread database.
If you open a file that has colors from a My Thread database that are unmodified copies of standard threads, but

do not exist as copies in your My Thread database, the color is identified and selected in the original thread range
when you click the color to change it.



cT014 Error: "The thread XX already exists in the selected Thread Database. Do
you want to overwrite it?"

This message appears if you try to use an existing thread name in a My Thread database. If you wish to overwrite
a single thread name, click Yes, otherwise click No. If multiple threads are selected, to overwrite the names click
All, otherwise click None.

cT015 Error: "The e-mail address has been recognized but the password is
incorrect.”

No connection can be made with the software registration database. A correct e-mail address has been used with
an incorrect password. Check the e-mail address and password, and try again.

cTto16 Error: "The e-mail address has not been recognized, please try again."

No connection can be made with the software registration database. An unknown e-mail address was used.
Check the e-mail address and password, and try again.

cT017 Error: "The e-mail address is incorrectly formatted."

No connection can be made with the software registration database. The e-mail used is not a valid e-mail
address. Check the e-mail address and password, and try again.

cT1018 Colors in PREMIER+™ 2 Embroidery System Files

The PREMIER+™ 2 Embroidery System displays threads in a file in the same way on any computer where it is
installed. That is, the colors used are the same even if they are reproduced slightly differently on different
monitors. You can print a worksheet to see the colors and color names used in a particular design. This is true,
even if you do not have all the threads in a design defined in the Standard or My Thread databases on your
computer.

This is because a PREMIER+™ 2 Embroidery System design has complete information for each of the threads it
uses.

Any of the following file types is a 'design’ that has full PREMIER+™ 2 Embroidery System thread definitions:

» Husqgvarna Viking/Pfaff .vp4 or .vp3 embroidery file
« PREMIER+™ 2 Create .edo design outline file
o Font.mft file

Only Husqvarna Viking/Pfaff .vp4 or .vp3 embroidery files can be used to import custom thread definitions into a
My Thread database.

Each thread used in a design falls into one of the following categories:

» Athread you have added to a My Thread database from the Standard Thread Database and which you
have not changed. This will apply to most of your colors if you have used a My Thread database to
catalogue your thread collection.

» Athread from the Standard Thread Database.

» Athread which you formerly added to a My Thread database from the Standard Thread Database, used in
some designs and then deleted from the My Thread database.

» A custom thread that has been added to a My Thread database. You could have added this yourself or
added it to a My Thread database from a design from somebody else.

» Athread from the Standard Thread Database that is not on your own Standard Thread Database because
your database is out of date.

» A custom thread defined in the file that does not appear in the your My Thread database.

The availability of threads in the Standard Thread Database and My Thread databases will only affect parts of the
PREMIER+™ 2 Embroidery System where you can change colors.

For example:



« Editing modules: PREMIER+™ 2 Embroidery/Extra, PREMIER+™ 2 Modify, PREMIER+™ 2 Card Shop,
PREMIER+™ 2 Family Tree, PREMIER+™ 2 PhotoStitch and PREMIER+™ 2 Sketch

» Design modules: PREMIER+™ 2 Create, PREMIER+™ 2 QuickFont, PREMIER+™ 2 Cross Stitcher and
PREMIER+™ 2 Font Create

cT019 | have a vp4 or vp3 embroidery from another user that uses a custom
thread definition they designed in a My Thread database
If you attempt to change the color, a message appears to indicate that the thread is not found in My Threads, and

the nearest My Threads match is selected. Use Import Threads from Embroidery to import the custom threads, or
select a replacement thread.

cT020 | have a design with custom colors that have been deleted from My
Thread database.

If you attempt to change the color, a message appears to indicate that the thread is not found in your My Thread
database, and the nearest My Thread match is selected. Select a replacement thread.

cT021 How can | give a copy of my thread definitions to a friend?

Use Export Threads to Embroidery in PREMIER+™ 2 Thread Cache to create a .vp4 embroidery from the
selected My Threads database to give to another user. When that embroidery is imported using Import Threads
From Embroidery. the threads are imported into a My Threads database with the same name as the original
database.

cT1022 How do | make a backup of my personal threads?

To make a backup of a single thread database, use Export Threads to Embroidery in PREMIER+™ 2 Thread
Cache.

To backup all of your thread databases for moving to a new computer, use Backup MySettings in PREMIER+™ 2
Configure.

EC003 | don't see the Embroidery Machine Communication icon in the system
tray when | start my computer.

You have not selected the option to start Embroidery Machine Communication automatically when Windows
starts. Resolve this as follows:

1. Start PREMIER+™ 2 Configure.

2. On the Utilities tab, click the Start Machine Communication button and the icon will appear in the system
tray.

3. Position the pointer over the icon in the system tray and right-click. A menu will appear.

4. Click the Start Automatically option.

5. Right-click the icon again to confirm the Start Automatically option is checked.

6. Click anywhere on the desktop, away from the menu, to close the menu without changing anything.

EC004 Can | connect more than one embroidery machine to my computer with
Embroidery Machine Communication?

You may connect one of each type of embroidery machine to the same computer. For example, you may connect
one Husqvarna Viking Designer SE, Diamond, Ruby and one Pfaff creative vision, 4.0 at the same time.

However, if you connect two or more of the same type of machine, the Embroidery Machine Communication
module will not communicate correctly with those machines.



This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

This message appears if there is a problem with your thread database. You will be unable to choose a thread
color.

First close all the modules of the PREMIER+™ 2 Embroidery System, close down your computer and restart.

If this does not clear the problem, restore a backup with Restore MySettings, if you have created one using
Backup MySettings in PREMIER+™ 2 Configure.

Otherwise, you either need a new version of the thread database, or a repair install of your PREMIER+™ 2
Embroidery System software. To check for the latest updates for the PREMIER+™ 2 Embroidery System, use
Smart Update in PREMIER+™ 2 Configure.

If the error still appears, then repair the installation. First, delete the following files from
ProgramData\VSMSoftware\Premier+2\System:

» User.sqlite
» System_cdb2.sqlite

This assumes you have installed your PREMIER+™ 2 Embroidery System software in the default location. If
these file are not present then this is the reason for the error. The file names may be shown without their file
extensions.

Put your PREMIER+™ 2 Embroidery System software USB stick in your computer and re-run the Applications
installation. (If you downloaded your software, double-click on the PREMIER+™ 2 Applications file.) When the
choice appears, select the "Modify or remove" option and click Next. In the next screen, select Repair and click
Next. Continue with the installation and follow the on-screen instructions. When the installation is complete, the
thread database will be restored to its original installation state. This means that the MyThreads database will
have the default set of threads.

This will also reset MyThreadRanges and custom Quick Color Themes to their installation states. Check Smart
Update in PREMIER+™ 2 Configure after repairing the installation.

This message appears if you attempt to click OK in the Color Selection dialog box when My Threads is selected
as the thread range and My Threads is empty.

To prevent this message appearing again, use PREMIER+™ 2 Thread Cache to add at least one thread to My
Threads.

Use Reset All Modules in PREMIER+™ 2 Configure to return all toolbars in the module to their default settings.
To use Reset All Modules

1. Ensure your designs are saved in any PREMIER+™ 2 Embroidery System modules that are open.

2. Click PREMIER+™ 2 Configure on the QuickLink toolbar.

3. Click Reset All Modules.

4. A message will appear, indicating that all modules will be closed and reset. Click OK.

5. A message will appear, asking you to ensure that all other PREMIER+™ 2 Embroidery System modules
have closed, apart from PREMIER+™ 2 Configure. Click OK.



6. A message will appear, indicating that all modules have now been reset. Click OK. The toolbars in your
module will have been restored.

If preferred, you can check individual toolbars in View, Customize. Use this to see if the missing toolbar has been
turned off, and also to reset the toolbar if icons have been added to or removed from the toolbar. If this does not
restore the toolbar, use Reset All Modules.

GA020 "Could not find xx in your database. Matching to closest thread in yy."

This message appears if the Thread Range of the selected color is not found in your thread database. This could
happen if the design you are attempting to edit was supplied by someone with a later version of the thread
database.

If you click OK, the color will be replaced with the nearest match in the Import Thread Range you have set
in PREMIER+™ 2 Configure. You can alter it to any other color if desired.
« If you click Cancel, the color will not be changed.

To import the new color from the embroidery if it is a MyThreads color, use Import Threads from Embroidery in
PREMIER+™ 2 Thread Cache.

To check for the latest updates for the PREMIER+™ 2 Embroidery System, use Smart Update in PREMIER+™ 2
Configure.

GA036 When | try to use Find Thread to select a thread number, the wrong
thread shade is selected.

The Find Thread feature in Color Selection allows you to enter partial thread numbers. The first thread in the list
matching the number is found, with priority given to an exact match. If you are attempting to find a thread with
only part of the number, the first thread matched may not be the desired thread. To ensure you select the correct
thread, enter the thread number as it appears in the list. Some thread ranges have prefix characters on the thread
number. These must also be entered to obtain an exact match.

GA043 "Cannot save file."

This message appears if, for instance, you have loaded an embroidery from a CD-ROM and then attempt to save
the embroidery back to the CD. A CD-ROM is read only, therefore you will not be able to save the embroidery.

GA045 Not enough memory available to perform function.

This message will appear if system resources are low. Close other programs and try again. If this does not work,
try restarting your computer.

GA046 \When | press the Help button | get the "Failed to launch help." error

Confirm PREMIER+™ 2 Embroidery System Documentation is Installed

This could be because you have not yet installed the PREMIER+™ 2 Embroidery System Documentation. You
can confirm if you have installed this by going to PREMIER+™ 2 Configure and clicking on the Check
Installation button and clicking Check to see which items you have installed.

Check you have the latest version of the PREMIER+™ 2 System Documentation installed
Use Smart Update to check you have the latest version:

1. Open PREMIER+™ 2 Configure.

2. Click on the Smart Update button.

3. Enter your E-mail Address/Password details.
4. Click Next.

5. Click Next again to start the Download process.
6. Follow the on-screen instructions.



GA057 Error 1304 when installing

If Error 1304 is reported when installing, do as follows:

« right-click the installation file, and in the context menu select Run as Administrator
« if this does not work, download the installation file again and restart your computer before reinstalling.

You may need to uninstall the previous version of the file from the Windows Control Panel before installing again.

GE026 Feature not available in this version.

This message will appear when trying to start a module or feature if the PREMIER+™ 2 Embroidery System
cannot detect an activation for that module or feature. Ensure that you have activated your software.

Your license may not cover this module or feature. To upgrade, see your dealer or look in the Purchase Center at:
www.EmbroideryPurchaseCenter.com

GE027 Error: "No apps are installed to open this type of link (file). Look for an
app in the Store."

This message will appear if the file association for HTML (the Help file format) has become disassociated. Reset
your file association for HTML files to your preferred browser.

Open the Control Panel in Windows, select Programs, then Default Programs, and then select "Associate a file
type or protocol with a program" (Set Associations). Browse down to .html, and ensure that your chosen browser
is selected as the default program.

GE029 Why can't | see the thumbnails for some of my designs?

When embroideries are saved in OneDrive folders, the thumbnails may not be visible, and the Notes information
in the embroidery cannot be searched. This is because the OneDrive technology stores the thumbnail on the
OneDirive server in the Cloud, where it is not accessible to the PREMIER+™ 2 Explorer Plug-in.

For example, a picture of a design may be seen when it is placed on the Windows Desktop, but not when itis in a
folder using Cloud storage.

To view the thumbnails and access the Notes for searching, configure OneDrive to store designs locally and on
the Cloud.

1. Open an Explorer window.

2. Right-click the OneDrive folder.

3. In the context menu, select Settings.

4. Click the Settings tab in the Microsoft OneDrive dialog box.

5. In Files On-Demand deselect (uncheck) 'Save space and download files as you use them'.

This will ensure that the files are always stored locally. Your files will still be synced with the Cloud and kept up to
date.

This will use up more storage space on your computer than if you keep your files on the OneDrive server and
download them as needed. If space is an issue, for example on a laptop used when travelling, you can hide some
folders (e.g. those containing videos) on the Account tab of the same dialog box. The hidden folders will no longer
be accessible to that computer.

GE030 How do | receive the Newsletter?

The PREMIER+™ 2 Embroidery Newsletter includes news, how-to advice and tips.
To receive the Newsletter:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Select'l do not have a previous registration' and then click Next.

3. Enter your name and email address, and check (select) the box 'l would like to receive an E-mail
Newsletter...".




To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE031 How can | check my Newsletter Subscription?

You can check if you are subscribed to the PREMIER+™ 2 Embroidery Newsletter in your Registration record.

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Ensure that the checkbox "l would like to receive an E-mail Newsletter..." is checked (selected).

If you cannot remember your password or the e-mail address that you used, click "l do not have a password, or |
have forgotten it" and request a password, create a new record, or contact software support.

To view the Newsletter archive, go to premier.embroiderynewsletter.net

GE032 Why aren't | getting the Newsletter?

You may not be receiving the PREMIER+™ 2 Embroidery Newsletter because you have not registered, you are
not subscribed, because it is being caught by a spam filter, or because it is being blocked by your ISP.

» To register for the Newsletter, see GE030
» To check if you are subscribed, see GE031

To ensure that you are receiving the Newsletter, do as follows:

o Check your spam or junk folder for the Newsletter. If you find it there, mark it as being Not Spam.
» Add info@embroiderynewsletter.net to your email Contacts or Address Book.

» Add info@embroiderynewsletter.net to the Whitelist or Safe Senders list for your email provider.
» Contact your ISP and ask them to stop blocking @embroiderynewsletter.net.

GE033 How do | Unsubscribe from the Newsletter?

You can Unsubscribe to the Newsletter from within the Newsletter itself, and from the Registration database.
If you no longer wish to receive the Newsletter, please Unsubscribe. Don't mark it as Spam.
From the Newsletter:

1. In the Newsletter itself, click the Unsubscribe link at the top right.

2. Click the link "If you would prefer not to receive any e-mail communication from us, please unsubscribe
here."

3. In the Unsubscribe page, enter your email address.

4. Uncheck (deselect) the box "l would like to receive an E-mail Newsletter...".

5. Click Next to unsubscribe.

You do not need to remember your password to Unsubscribe this way.
From the Registration Database:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. Uncheck (deselect) the box 'l would like to receive an E-mail Newsletter...".

4. Click Next to unsubscribe.

GE034 How do | change the Password for my Registration?

You can change the password for your registration from within the Registration Database, or by having a new
password sent to you by email.

To have a new password sent to you:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)
2. Click "I do not have a password, or | have forgotten it."

3. Enter your email address and click Next.

4. Check your email for a message with your new password in it.



5. Log in to your account with your new password.
To change your password (for example to choose a more memorable password), do as follows:

1. Go to Registration. (https://www.vsmsoftware.net/DBv4/User/Login.aspx)

2. Enter your E-mail Address and Password into the text fields, and then click Next.
3. In the Name and E-mail Address page, click Main Menu at the bottom left.

4. In the menu on the left, click Account Password.

5. Enter your old password at the top, followed by your new password twice.

6. Click Next to save your new password.

You must use a strong password.

» Your password must be at least 8 characters long.
» At least one character must be neither a letter nor a number (for example !,&?).

HM001 Exporting to the Brother PR1000e

When exporting to a .PEC file for the Brother PR1000e, Stop commands are automatically converted to Color
Change commands. As a result, the number of color changes on the printed worksheet may not match the
number seen on the machine.

IN014 Do | need to uninstall my Premier+™ Software to install the PREMIER+™
2 Software?

You do not need to uninstall the 6D or Premier+™ Software when you come to installing the PREMIER+™ 2
Embroidery System; all systems will co-exist on the same computer without issues.

The only exception being, that the 6D and Premier+™ Explorer Plug-in will need to be uninstalled to allow the
PREMIER+™ 2 Explorer Plug-in to be installed

IN015 What are the features in the latest Smart Update?

The best way to find out which features are in the latest Smart Update (or previous upgrades) is to:

1. Double click on the PREMIER+™ 2 Embroidery System shortcut on your Desktop. A new Windows®
Explorer window will appear

2. Double click on Readme shortcut.

3. Open the latest file.

4. The latest features will be listed at the top of the document.

INo16 Will the PREMIER+™ 2 Embroidery System run on a Mac?

There is a Mac version of the PREMIER+™ 2 Embroidery System, use that version on a Mac.

The Windows® version of the PREMIER+™ 2 Embroidery System is intended to be run on a Windows®
computer.

Although, many customers have been able to get it to work fully using 3rd Party environments like Parallels and
Boot Camp; we cannot support the software when it is run in a non-standard setup or using 3rd Party tools.

IN019 Error; ParentFrame download failed. Error #Permission denied.

This error can happen when an issue has been found in the integrity of the downloaded file during the Smart
Update process.

1. Close down all open programs.
2. Restart your computer.
3. Start the Smart Update process again.



IN022 Error 1722 reported when installing or uninstalling the Explorer Plugin

Error 1722 appears when an installation of the Explorer Plugin may have become corrupted. Use the PREMIER+
2 Explorer Plugin Fix utility to correct this problem.

1. Download the PREMIER+ 2 Explorer Plugin 1722 Fix utility here.

2. Double click on the downloaded PremierPlus2ExplorerPluginFix.exe file
3. Follow the on-screen instructions

4. Now try to install the PREMIER+ 2 Explorer Plugin installation file again.

wso008 Which devices can PREMIER+™ 2 online documentation be viewed
with?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

The PREMIER+™ online documentation can be viewed on Windows* and Mac computers, iOS and Android
devices.

*Windows 10 can view ePUB files via the Microsoft Edge browser; earlier versions of Windows may not have
compatibility to read ePUB files.

wso009 Can you recommend an iOS or Android app that | can use to read ePUB
files?

On iOS devices, the default app for reading ePub files is usually iBooks. On most Android* devices, the default
app for reading ePUB is usually Google Play Books.

Other reading apps that you may already have on your iOS and Android devices may also be able to read ePUB
files

*Some manufacturers of Android devices use a customized version of the Android operating system that may not
have Google Play Books installed.

wso010 Which is the best PREMIER+™ 2 online documentation format for my
device?

The PREMIER+™ 2 online documentation is available in PDF, ePUB and HTML formats.

Each of these formats has their own strengths and minor limitations. Depending on which device you are using,
any of these formats may qualify as ‘best format'. It will come down to personal preference.

Take the time to view them all on your device; and decide which one gives you the best reading experience.

wso11 How do | view the PREMIER+™ 2 online documentation on my Apple
IOS or Android device?

Due to large variations of Apple iOS and Android devices (and versions of operating system), we cannot
provide Support on viewing the PREMIER+™ 2 online documentation on your mobile devices

To view the PREMIER+™ 2 online documentation on your Apple iOS or Android device:
Downloading

1. Open an internet browser on your mobile device.

2. Go to the PREMIER+ 2 Brochures & Guides page.

3. In the Guides section of the page, click on the Ref Guides tab

4. Click on the relevant Reference Guide (and format) that you would like view
5. It will start a download process in your internet browser

Viewing:



Apple iOS:

When the download is complete in the internet browser, you may get the Open in "iBooks" option. Click on that
link to view the ePub file iBooks.

Android:

When the ePub file has completed downloading, tap on the downloaded file to open it in Google Play Books (or
an alternative reading app).

* PDF files will be easily viewable on most mobile devices without requiring special instructions.
** The HTML documentation cannot be downloaded, but it will act in a similar manner to browsing a website.



